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Overview and New Features
This Dentrix G6.6 Release Guide provides information about the Dentrix G6.6 software release. This 
overview section includes important notes regarding the release, followed by a brief description of the 
new features and enhancements available in Dentrix G6.6.

Note: For information about using the new features in Dentrix G6.6, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6.6?” in the Dentrix Help. 
For information on installing Dentrix, refer to the Installation Guide.

New Features
Dentrix G6.6 includes the following enhancements:

DENTRIX PAY

•	 Dentrix Pay is credit card transaction processing native to Dentrix that you use to process charges and 
credits by inserting, swiping, or tapping a credit card. Dentrix Pay uses an Ingenico iPP320 payment 
device that supports EMV-chip technology in payment cards and mobile payment applications that 
use NFC (Near Field Communication). For more information, see “Dentrix Pay” in the Dentrix Help in 
the Office Manager and the Ledger.

FILL APPOINTMENT

•	 Fill Appointment is a text messaging service that you can use to message up to 40 patients to fill 
available appointment times in the Appointment Book from the ASAP, Broken, Continuing Care, Will 
Care, and Pinboard lists. A text message can consist of up to 160 characters. Once a text message 
exceeds 160 characters, you will receive a message indicating that multiple text messages may be 
sent. The maximum number of characters is 320. For more information, see “Fill Appointment” in the 
Dentrix Help.

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of features and enhancements, refer to the Dentrix Help.

Dentrix Pay
Dentrix Pay is credit card transaction processing native to Dentrix that you use to process charges and 
credits by inserting, swiping, or tapping a credit card.

Dentrix Pay processes credit cards through Moneris Solutions, Inc. (a Vantiv company), a third-party credit 
card merchant processor. To use Dentrix Pay, you must have Internet access, you must have an Ingenico 
iPP320 payment device, and you must set up and activate a Moneris Gateway account. For details about 
how to set up a Moneris account, contact eServices Sales at (800) 734-5561.

After setting up a Moneris account, you will receive an email message or a letter from eServices with 
instructions on how to activate the Moneris Gateway service. The email message or letter will also include 
the following required information, which you will need to register for payment processing through 
Moneris and during the setup of Dentrix Pay:

•	 Merchant Name

•	 Moneris Merchant ID

•	 Moneris Gateway Store ID

•	 Moneris ECR IDs for your devices
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ENABLING AND SETTING UP DENTRIX PAY IN THE OFFICE MANAGER

Once you have set up your Moneris account, you can enable and set up Dentrix Pay in the Office 
Manager.

To enable and set up Dentrix Pay in the Office Manager

1.	 Click Maintenance, point to Practice Setup and then Dentrix Pay, and click Enable Dentrix Pay.

The Dentrix Pay Setup dialog box appears.

2.	 In the Store ID text box, type your store ID.

Note: If you have not yet received a store ID and an API token or have not yet registered with Moner-
is for Moneris Gateway payment processing, contact eServices Customer Support at (800) 734-5561.

3.	 In the API Token text box, type or paste your API Token.

Tips: 

•	 We recommend that you copy the API Token that you received from Moneris and paste it in the 
API Token text box to avoid making typing errors.

•	 If you type the API token, as you type, the text is masked. However, to help you verify that your 
entry is correct when you click in the text box to type or modify the text, the text you entered 
appears temporarily above the text box. Once you click Save, the API token is masked.

4.	 You must set up your Ingenico iPP320 PINpad device before you can process transactions:

a.	 Connect your Ingenico iPP320 to the computer you will process credit card payments on and wait 
for the iPP320 screen to display one of the following messages:

•	 INIT REQUIRED

•	 LOGON REQUIRED

•	 WELCOME

b.	 Click Setup/Update Device Connected to this PC.

The Setup or Update Device Connected to this PC dialog box appears.
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Note: The COM Port and PINpad Serial # fields are auto-detected from the device connected to 
the computer.

c.	 Enter the Associated ECR ID that you received in the welcome letter from eServices.

Important: Each workstation that you use with Dentrix Pay requires a unique ECR ID.

d.	 Click Setup/Update Device.

Your device starts updating with the latest configuration for your Moneris account. This process 
can take several minutes. When the update is complete, you can process transactions.

5.	 In the Dentrix Pay Setup dialog box, set up the following options:

•	 Sign with ePad – If you have an Interlink ePad device, you can use it to sign receipts after 
payments are processed.

•	 Print the following as footer information on receipts? – Select to print a note or message at the 
bottom of each receipt. You can type whatever message you want to appear in the footer. 

•	 Receipt Printer – Select the printer you want to print receipts. By default, this is the Microsoft 
Windows default printer.

•	 Receipt Printing Default – Select if you want to print the merchant receipt only, the customer 
receipt only, or both receipts.

•	 Moneris – Click to open the Moneris Gateway Merchant Resource Center website. After logging 
in to the website, you can view payment processing reports and manage your account.

6.	 Click the Ledger Posting Options tab.

The Dentrix Pay Setup dialog box appears.



	 Dentrix G6.6      5

Dentrix G6.6  Release Guide

7.	 Select the payment types that you want to associate with processing credit card payments, and then 
click OK.

PROCESSING CREDIT CARD PAYMENTS IN THE LEDGER

After setting up Dentrix Pay, you can use Dentrix Pay to process and post payments and to submit refunds 
and voids using the Ingenico iPP320 PINpad device.

To process a credit card payment in the Ledger

1.	 With a patient selected in the Ledger, click Transaction, and then click Enter Payment.

The Enter Payment dialog box appears.
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2.	 In the Amount text box, type the payment amount, select how you want to allocate the payment, 
select whether to apply the payment to the selected patient or family balance, and enter any notes 
regarding the transaction.

3.	 Select the appropriate credit card payment type (indicated by a credit card icon).

The OK button changes to Process Card.

4.	 To process the payment, complete one of the following tasks:

•	 Insert, swipe, or tap a card.

a.	 Click Process Card.

The Dentrix Pay Device Status dialog box appears.

b.	 On the iPP320 device, select Debit or Credit, 

•	 Manually enter the card number on the device.

a.	 Select Manually enter card number.

b.	 Click Process Card.

The Dentrix Pay Device Status dialog box appears.



	 Dentrix G6.6      7

Dentrix G6.6  Release Guide

c.	 On the iPP320 device, type the card number, and then press the green button.

d.	 As prompted, enter the card’s expiration date and CVD code.

The card processes through the Moneris Gateway, and when the transaction is complete, the Dentrix 
Pay Transaction Completed dialog box appears indicating whether the card was approved or denied.

Note: If you selected Sign with ePad in the Dentrix Pay Setup dialog box and have set up an ePad 
device, the cardholder is prompted for a signature if the transaction is approved.

5.	 Complete one of the following options:

•	 To print a receipt, select the appropriate option from the Print Options list, and then click Print 
Receipt.

Note: You can set up the default state of this option in the Dentrix Pay Setup dialog box.

•	 To close without printing a receipt, click Close.

The payment posts to the patient’s ledger.

Fill Appointment
Fill Appointment is a text messaging service that you can use to message up to 40 patients to fill available 
appointment times in the Appointment Book from the ASAP, Broken, Continuing Care, Will Care, and 
Pinboard lists.

Important: You must have an active eCentral account to use Fill Appointment. To set up an eCentral ac-
count, call 1-800-Dentrix.

SETTING UP FILL APPOINTMENT

You can use Fill Appointment to fill available appointment times in the Appointment Book.

To set up Fill Appointment

1.	 In the Options menu in the Appointment Book, click Fill Appointment.
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2.	 In the Fill Appointment List window, click the Setup button.

The Fill Appointment Setup dialog box appears.

3.	 Complete the following tasks:

•	 Select Provider – Select the provider or providers whose schedules you want to fill.

•	 List Type – Select the type or types of appointment lists you want to search.

•	 Span of Search – Select one of the options from the list.

•	 Length – Select one of the options from the list.

4.	 Set a date range in the From and To lists, and then click OK.

To send a text message

1.	 In the Options menu in the Appointment Book, click Fill Appointment.

2.	 In the Fill Appointment List window, select the patients you want to send a text to, and then click Text 
Setup.

The Text Setup dialog box appears.

3.	 Type the message you want to send in the Text Message text box.

4.	 Under Office Confirmation Email, add an email address that you want to send a confirmation to.

5.	 Click Send, and in the Send Text dialog box, select I agree to the Dentrix eCentral Terms and 
Conditions, and then click Yes.
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What’s Changed?
The list below contains the fixes and changes that have been included in the Dentrix G6.6 release.

APPOINTMENT BOOK 

•	 The ASAP List continued to display appointments that were set complete. This has been fixed. 

•	 Adding more than 20 procedures to an appointment did not generate an error message. This has 
been fixed. 

•	 An error message incorrectly indicated that you could not assign more than 10 procedures to an 
appointment. The limit is no more than 20 procedures. This has been fixed. 

•	 When you set a Continuing Care appointment to complete and automatically scheduled the next 
appointment, the creation date for the next appointment was set to the last date the original 
appointment was edited. This has been fixed. 

•	 All deleted appointments in the Appointment History List had a 12:00 A.M. timestamp. This has been 
fixed. 

•	 If you changed practice and provider hours, the finding available times feature did not find all 
available times. This has been fixed. 

•	 After archiving patients, you could still set appointments for them. This has been fixed. 

•	 Appointments scheduled until midnight could not be dragged to another time. This has been fixed. 

•	 When a patient has multiple appointments, the Scheduled Patient Summary Report sorts 
alphabetically regardless of the selected sort order. This has been fixed. 

DOCUMENT CENTER

•	 The chevron buttons for setting ranges in several dialog boxes did not display correctly. This has 
been fixed. 

•	 The links to attached documents were not purged when insurance plans were purged. This has been 
fixed. 

FAMILY FILE

•	 In the Gratuity dialog box, you could attach gratuities to inactive providers. This has been fixed. 

LAB CASE MANAGER

•	 The From and To chevron buttons required two clicks to perform an action. This has been fixed. 

•	 The Delete Case(s) option was enabled even if no patient was selected. This has been fixed. 

LEDGER

•	 If you selected Show Inactive Providers in the Split Payment dialog box, inactivated providers did 
not appear in the provider list. This has been fixed. 

•	 The Copy All Payment Agreement Notes button was enabled for new payment agreements. Only 
the New Payment Agreement Note button should be enabled for a new payment agreement. This 
has been fixed. 

•	 When you edited a payment, provider balances did not update correctly. This has been fixed. 

•	 Pressing the Delete or Backspace keys to remove an amount from the Amount text box in the Enter 
Payment dialog box did not remove the entire amount. This has been fixed. 

•	 If a Patient Ledger Report was longer than 18 pages, payment amounts were incorrect. This has been 
fixed. 
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OFFICE JOURNAL

•	 When a note begins with a hard return, the OK button is not enabled. This has been fixed. 

•	 If you added an entry to the Office Journal through the More Information dialog box, you could 
enter any text as a note type, and if the text you entered was not valid, the type was set to Billing 
Statement. This has been fixed. 

•	 Switching patients in the Office Journal took more time than opening the Office Journal for each 
patient separately. This has been fixed. 

•	 Other Dentrix modules stopped responding if the Office Journal opened slowly. This has been fixed. 

OFFICE MANAGER

•	 If you ran an Audit Trail Report on a large database, the report was not generated, and you could not 
run any other reports. This has been fixed. 

•	 An unhandled exception occurred if you added procedures to a multi-code and the total time 
exceeded 240 minutes. This has been fixed. 

•	 The Insurance Carrier List printed with the label printer offsets. This has been fixed. 

•	 The Appointment History List did not show all of the appointments in the selected date range. This 
has been fixed. 

•	 The Aging Report took three times longer to process compared to earlier versions of Dentrix. This 
has been fixed. 

•	 Totals in the Day Sheet Report and the Practice Analysis Report for the same date range did not 
match. This has been fixed. 

PATIENT CHART

•	 The Graphic Chart depicted a bridge charting symbol connected to an extracted tooth. This has been 
fixed. 

QUESTIONNAIRES

•	 If you modified and included all patient information questions, an error message appeared indicating 
that the patient’s information could not be updated. This has been fixed. 

•	 If you were previewing a patient’s questionnaire in the Print Preview window then switched to a blank 
questionnaire and changed the font size, the “blank” questionnaire contained the responses to the 
patient’s questionnaire that you were viewing previously. This has been fixed. 

•	 Masking a Social Security number removed it from Enter New Responses. This has been fixed. 

•	 Social Security numbers incorrectly appeared in yellow in the PI-Spouse Responsible Party, All and the 
PI-Spouse Responsible Party, Brief questions. This has been fixed. 

MISCELLANEOUS

•	 Instead of restarting from the point the download stopped, the Update Manager started the 
download from the beginning when you clicked the Retry button. This has been fixed. 

•	 An unhandled exception appeared when you clicked Delete Snapshot. This has been fixed. 

•	 The Password dialog box did not move to the front when some modules were opened. This has been 
fixed. 

•	 In ePrescribe, you could not use a comma in the Name text box as in Smith, Jr. This has been fixed. 
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Overview and New Features
This Dentrix G6.5 Release Guide provides information about the Dentrix G6.5 software release. This 
overview section includes important notes regarding the release, followed by a brief description of the 
new features and enhancements available in Dentrix G6.5.

Note: For information about using the new features in Dentrix G6.5, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6.5?” in the Dentrix Help. 
For information on installing Dentrix, refer to the Installation Guide.

New Features
Dentrix G6.5 includes the following enhancements:

APPOINTMENT LIST

•	 You can now manage the Appointment, ASAP, Open, Unscheduled, and Pinboard lists through a 
single Appointment List window. To learn more, refer to “Appointment Lists overview” in the Dentrix 
Help.

REPORTS AND TASKS SCHEDULER

•	 The Reports and Tasks Scheduler replaces the Month-End Wizard and Month-End Update. You are 
no longer required to close Dentrix on all of your office computers to do your month-end tasks. In the 
Reports and Tasks Scheduler, you can schedule reports or tasks to run automatically at daily, weekly, 
monthly, or yearly intervals, or you can run them immediately or just once. For example, you could 
apply finance charges automatically on the fifteenth day of every month or the first Tuesday of each 
month. To learn more, refer to “Reports and Tasks Scheduler” in the Dentrix Help.

QUESTIONNAIRES

•	 The With Responses and Needs Responses tabs were removed from the Questionnaires module. 
You can now view forms and questionnaires at a single glance in the Questionnaires List pane. 
The Questionnaires List pane contains five columns: Form Name, Response Date, Expiration 
Date, Update Patient Info, and Signed. The Questionnaires List is also divided into two sections: 
Completed and No Response. To learn more, refer to “The Questionnaires List overview” in the 
Dentrix Help.

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of features and enhancements, refer to the Dentrix Help.

Appointment Book
You can now manage the Appointment, ASAP, Open, Unscheduled, and Pinboard lists through a single 
Appointment List window.

APPOINTMENT LIST

The Appointment List displays all appointments scheduled in the Appointment Book for a selected 
date. In the Appointment List, you can view the time, status, eligibility, patient name, provider, operatory, 
reason, length, and patient phone numbers for the appointment. You can also see the production amount 
totals for the selected appointment and the day.
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To open the Appointment List window

1.	 In the Appointment Book menu, click Appt List.

The Appointment List window appears.

Note: By default, the Appointment List window displays all scheduled appointments for the current 
date, not the date you may have selected in the Appointment Book.

2.	 Click the date down arrow and select a date from the calendar to view the appointments for that day 
rather than the current one.

3.	 To see more information about or to make changes, double-click an appointment.

The Appointment Information dialog box appears from which you can make the changes you want to 
the appointment.

4.	 To open the ASAP, Unscheduled, or Pinboard lists, click the Select List down arrow, and select the list.

The appointments associated with the type of list you selected appear.

Ledger
The Reports and Tasks Scheduler replaces the Month-End Wizard and Month-End Update. You are 
no longer required to close Dentrix on all of your office computers to do your month-end tasks. In the 
Reports and Tasks Scheduler, you can schedule reports or tasks to run automatically at daily, weekly, 
monthly, or yearly intervals, or you can run them immediately or just once.

REPORTS AND TASKS SCHEDULER

The Reports and Tasks Scheduler dialog box consists of the Available Tasks and Scheduled Tasks lists. 
The Scheduled Tasks list is divided into Daily, Monthly, and Yearly queues, and each queue lists the 
reports or tasks that we recommend you run within those time frames. (These tasks are suspended until 
you schedule one from the Available Tasks list.)

You can add other reports and tasks from the Available Tasks list based on the needs of your practice. 
The Available Tasks list is divided into the following categories: Ledger Reports, Ledger Tasks, 
Management Reports, Move to History, and Purge and Reset.

To add a report or task to a queue

1.	 In the Ledger menu, click Task Scheduler (Month End).
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The Reports and Tasks Scheduler dialog box appears.

2.	 In the Available Tasks list, double-click  the report or task that you want to add to a queue.

The Task dialog box appears.

3.	 Select Add to Queue.

4.	 Click the down arrow, and select one of the following queues from the list:

•	 New Queue

•	 Daily

•	 Monthly

•	 Yearly

5.	 Click OK.

A dialog box appears corresponding to the report or task. For example, if you selected Apply 
Finance Charges, the Apply Finance Charges dialog box appears. (See “Applying finance charges” 
in the Dentrix Help.

6.	 Set the parameters of the report or task in the dialog box and click OK.

The report or task is added to the Scheduled Tasks list.

Note: By default, all tasks start processing at 12:00 AM. You can change this time.

7.	 To set how often the report or task recurs, select it in the Scheduled Tasks list, and then click Edit to 
the right of the appropriate queue name.

The Edit Queue dialog box appears.
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8.	 For a monthly report or task, select Day, and then set the day of the month and how often the task 
recurs. For example, Day 1 of every 1 month(s) means the task recurs on the first day of every month. 
Or, select the second option to set the task to recur on the first, second, third, or fourth selected day 
of the week every month. For example, to run a task on the second Tuesday of every month, you 
would select: Second, Tuesday, and the number 1.

9.	 Click OK.

The report or task is scheduled to run according to the parameters you set.

Tip: Click the Schedule button to verify the schedule.

Questionnaires
The Questionnaires window was modified. The With Responses and Needs Responses tabs were 
removed and the List pane was divided into two sections. You can now view forms and questionnaires at a 
single glance in the Questionnaires List pane.

To open the Questionnaires module

1.	 In the File menu in the Patient Chart, point to Switch To, and then click Questionnaires.

The Questionnaires window appears.
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The Questionnaires List pane consists of the following five columns:

•	 Form Name – Name of the form or questionnaire.

•	 Response Date – Date a patient responded to the form or questionnaire.

•	 Expiration Date – Indicates when or if the form or questionnaire expires.

•	 Update Patient Info – Indicates whether a patient’s information needs to be updated.

•	 Signed – Indicates whether a patient signed a form or questionnaire.

The List pane is also divided into a Completed section and a No Responses section, so that you can 
see at a glance which questionnaires patients have responded to and which they have not.

What’s Changed?
The list below contains the fixes and changes that have been included in the Dentrix G6.5 release.

APPOINTMENT BOOK 

•	 If you deleted appointments from the bottom of the ASAP List window, odd characters and error 
messages appeared below the last item in the list. This has been fixed. 

•	 The ASAP List window incorrectly duplicated or removed appointments from the list. This has been 
fixed. 

•	 If you minimized the ASAP or Unscheduled List windows and dragged an appointment from the 
Appointment Book to the Pinboard or from the Pinboard to the Appointment Book, the Appointment 
Book stopped responding until the ASAP or Unscheduled List windows refreshed. This has been 
fixed. 

•	 If you created a new patient appointment and then clicked the New Pat Inf button in the 
Appointment Information dialog box before saving the appointment, the patient’s mobile phone 
number and email address were deleted. This has been fixed. 

•	 If you set up an event to occur two days a week for a month and then re-opened the event to edit it, 
every day of the week was selected instead of the two days you selected. This has been fixed. 

•	 The Place of Treatment text box in the Insurance Claim Information dialog box was always enabled 
instead of only when you selected Other. This has been fixed. 

•	 You could set appointments complete without having the permissions to do so. This has been fixed. 

•	 The blue musical note was missing from appointment blocks after upgrading Dentrix. This has been 
fixed. 

•	 Moving an appointment from the Unscheduled List to the Appointment Book did not remove it from 
the Unscheduled List. This has been fixed. 

•	 The character limit in the Email text box in the New Patient Appointment dialog box was increased 
to 59 characters to match the limit in the Family File. 

DOCUMENT CENTER

•	 An error message appeared when you closed the Unfiled Documents window. This has been fixed. 

•	 The Document Center list was empty for selected patients even though the Family File showed that 
documents were attached to those patients. This has been fixed. 

FAMILY FILE

•	 A new line was not created when you pressed the Enter key in the Medical Alerts text box. This has 
been fixed. 

•	 If you previewed or printed a Route Slip, referral information did not appear on the slip. This has been 
fixed. 
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•	 If you added a +4 entry to a patient’s Zip code and then did a letter merge, the +4 entry was missing 
occasionally. This has been fixed. 

LAB CASE MANAGER

•	 In the View dialog box, if you used the select buttons (chevrons) to select an option, you had to click 
OK twice before your selections took effect. This has been fixed. 

LEDGER

•	 Total adjustments and total amounts fields in Total Insurance Payment and the Batch Insurance 
Payment Entry dialog boxes were not working properly. This has been fixed. 

•	 If you split a primary claim, attachments disappeared. This has been fixed. 

OFFICE MANAGER

•	 The Practice Definitions dialog box accepted more than 30 characters in Definition Text field. This 
caused the Ledger to stop responding. This has been fixed. 

•	 Typing codes in the Enter the code for faster selection text box did not select a code from the list. 
This has been fixed. 

PERIO CHART

•	 When you performed a new exam the Plaque, Mobility, and Bone Loss items did not have focus. This 
has been fixed. 

PRESCRIPTIONS

•	 The last number in the date was missing when you printed a prescription if you selected DAW 
Signature, Right (Multi State). This has been fixed. 

•	 The refill amount was blank when you printed a prescription. This has been fixed. 

QUESTIONNAIRES

•	 “Patient Name” was changed to “Name” in the Spouse or Responsible Party section of the Patient 
Information form because a responsible party might not be a patient. 

•	 Tooltips did not appear when the Show Changes and Compare to Previous toolbar buttons did not 
have focus. This has been fixed. 

•	 The Consent for Implant Surgery form in the Sample database contained errors. This has been fixed. 

•	 If you tried to update a patient’s information through updating patient information while that patient’s 
Family File was open, update patient information stopped responding until you closed the Family 
File. This has been fixed. 

•	 Update patient information indicated that information in Questionnaires differed from information in 
the Family File when the information was identical. This has been fixed. 

•	 The Signed and Prov columns did not display any information until you clicked the Refresh toolbar 
button. This has been fixed. 

•	 Buttons in the Questionnaire Form Setup dialog box were not working correctly. This has been fixed. 

TREATMENT PLANNER

•	 The Practice Signature was mislabelled in the Consent Form. This has been fixed. 

•	 The All Dates button remained selected even after you specified a procedure code or a case fee 
expiration date range. This has been fixed. 

•	 The same patient alert appeared twice when you opened the Treatment Planner. This has been fixed. 
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MISCELLANEOUS

•	 If you added an Office Journal entry through the Collections Manager by copying text from a Quick 
Letter, the Collections Manager stopped responding. This has been fixed. 

•	 If you generated a billing statement using the Month-End Wizard, the insurance flag asterisk did not 
appear. This has been fixed. 

•	 The text of a “misspelled” word remains red even after you add the word to the dictionary. The text 
remains red until you close and reopen the note. This has been fixed. 

•	 The Daily Huddle Report incorrectly reported split payment amounts. This has been fixed. 

•	 If the Time Clock was already running in the background and you clicked its icon in the Launcher, a 
second instance of the Time Clock opened rather than the first instance coming to the foreground. 
This has been fixed. 



Dentrix G6.4
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Overview and New Features
This Dentrix G6.4 Release Guide provides information about the Dentrix G6.4 software release. This 
overview section includes important notes regarding the release, followed by a brief description of the 
new features and enhancements available in Dentrix G6.4.

Note: For information about using the new features in Dentrix G6.4, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6.4?” in the Dentrix Help. 
For information on installing Dentrix, refer to the Installation Guide.

New Features
Dentrix G6.4 includes the following enhancements:

LEDGER

•	 The new Payment Agreement Manager allows you to manage payment agreements and to post 
payment agreement payments from a single location for multiple accounts.

•	 The Billing/Payment Agreement dialog box was enhanced to make it more intuitive.

•	 The Total Insurance Payment dialog box was enhanced so that you can record credit card payments.

MISCELLANEOUS

•	 The Dentrix G6.4 installation package includes the CDT 2017 update.

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of features and enhancements, refer to the Dentrix Help.

Ledger 

PAYMENT AGREEMENT MANAGER

Dentrix now includes a Payment Agreement Manager that allows you to manage payment agreements 
and to post payments to multiple accounts from a single location. Payment Agreements are set up by 
account and not by patient.

To enter a payment agreement payment with the Payment Agreement Manager

1.	 With a patient selected in the Ledger, in the File menu, click Payment Agreement Manager.

The Payment Agreement Manager window appears.
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2.	 Click Enter Payment or the Enter Payment toolbar button.

The Enter Payment dialog box appears.

3.	 Use the following options to enter a payment:

•	 Date – If necessary, type a new date, or select one from the calendar.

•	 Payment Types – Select the appropriate payment type from the list.

•	 Amount – Type the amount of the payment.

•	 Check/Payment # – Type the check or the payment number.

•	 Bank/Branch # – Type the appropriate number. (This number appears on the Dentrix Deposit 
Slip.)

•	 Provider – Defaults to Split By Provider.

•	 Patient – Defaults to the selected patient.
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•	 Split Method – Select one of the following options:

•	 Percentage Payments – Divides the payment among the providers according to the 
provider’s percentage of the total amount owed.

•	 Guarantor Estimate – (Default) Applies the payment to providers who have balances as 
guarantor estimates and ignores provider balances that Dentrix estimates insurance will pay 
the remainder of.

•	 FIFO (First In First Out) – Applies the payment toward the oldest completed procedures first.

•	 Equal Payments – Splits payment amounts equally among all providers with debit balances.

•	 Note – If appropriate, type a note.

4.	 Click OK.

PAYMENT AGREEMENTS

The Billing/Payment Agreement dialog box was modified to make setting up payment agreements 
easier. For more information on setting up and managing payment agreements, see “Payment 
agreements overview” in the Dentrix Help.

To create a payment agreement

1.	 With a patient selected in the Ledger, in the File menu, click Billing/Payment Agreement.

The Billing/Payment Agreement Information dialog box appears.

2.	 The current date appears in the Agreement Date field by default.

Note: If necessary, you can click the Down arrow to change the date of the agreement.

3.	 Use the following options to set the terms of the payment agreement:

•	 Interval – Select the payment interval from the list:

•	 Monthly – Requires a payment once a month.

•	 Semi-monthly – Requires a payment twice a month.

•	 Bi-weekly – Requires a payment every two weeks.

•	 Weekly – Requires a payment once a week.

•	 Annual Finance Charge % – Type the amount of the finance charge.
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•	 Total Agreed Amount – To change the amount, type the total that you agreed to finance. (By 
default, Dentrix enters the total amount of the patient’s account.)

•	 First Payment Date – The default is the current date. To change the date, type a new date or click 
the Down arrow and click the appropriate date in the calendar.

4.	 Do one of the following:

•	 Payment Amount – Type the amount of each payment, and Dentrix automatically calculates the 
number of payments.

•	 # of Payments – Type the number of payments or set them using the spin box, and Dentrix 
automatically calculates the amount of each payment.

5.	 To apply late charges, select Late Charges.

6.	 Use the following options to set the terms of late charges:

•	 Annual Late Charge % – Type an annual percentage rate. Dentrix uses the percentage rate to 
calculate the monthly amount of the late charge. For example, if you use 18% as the annual rate, 
Dentrix calculates a monthly late charge of 1.5%.

•	 Grace Period (Days) – Type the number of days or set them using the spin box.

•	 Minimum Late Charge – Type the minimum amount to assess as a late charge.

•	 Minimum Balance to Charge – Accounts with a balance greater than the minimum receive a 
finance or late charge. The default minimum is $0,01. You may increase this amount, but you 
cannot make it less than $0.01.

7.	 To note the terms of the payment agreement or to create a guarantor note, click the Copy 
Agreement to Note or the Guarantor Notes button respectively.

8.	 Click OK.

INSURANCE PAYMENTS

You can now post insurance payments that were made by credit card. This feature applies to dental and 
medical insurance payments.

To post an insurance payment made by credit card

1.	 Create a dental or medical insurance claim.

2.	 From the Enter Payment menu in the Insurance Claim window, click Total Payment Only.

The Total Insurance Payment dialog box appears.
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3.	 Select Credit Card Payment from the Payment Type list, and then type the last four digits of the 
credit card number and a short description (up to 20 characters – card type for example) in the 
corresponding fields.

4.	 Under Provider Amounts, do the following:

•	 Select Family Balance to add the amount owed the provider to the patient’s family balance.

•	 Select Patient Balance to add the amount owed the provider to the patient’s balance only.

•	 Select the entry in the list box, and do one of the following:

•	 Add – Click if the provider you want to credit the payment to is not listed. In the Provider 
Payment dialog box, click the Provider search button and select the appropriate provider. 
Type the amount in the Amount Paid text box and click OK.

•	 Edit – Click if the provider you want to credit the payment to is listed. In the Provider 
Payment dialog box, type the amount paid, and then click OK.

•	 Re-apply Amt using FIFO – Click to re-apply the amount of the total payment to the oldest 
provider balances first and then to more recent provider balances (if any of the payment 
amount is left over to do so).

5.	 If the patient paid a deductible, under Deductible Applied For Claim, type the amount in one of the 
following text boxes:

6.	 Click OK/Post.

What’s Changed?
The list below contains the fixes and changes that have been included in the Dentrix G6.4 release.

APPOINTMENT BOOK 

•	 You could not set an appointment if the amount in the Amount Set field exceeded 6 characters. This 
has been fixed. 

•	 If you opened an appointment with continuing care attached, the Patient Pending C. Care dialog 
box appeared with nothing selected. If you clicked OK to close the dialog box, the continuing care 
was removed from the Appointment Book. This has been fixed. 

•	 The time in the Appointment History tab was incorrect if the appointment was scheduled from 12:00 
PM to 1:00 PM. This has been fixed. 

•	 The Note and Medical Alert icons were inaccessible if an appointment block’s border extended 
beyond the bottom of the Appointment Book window. This has been fixed. 

•	 The Medical Insurance Claim Information dialog box wouldn’t open when you tried to view 
treatment-planned cross-coded procedures. This has been fixed. 

DOCUMENT CENTER

•	 An error appeared if you set up Auto Acquire but did not use the default DPI setting. This has been 
fixed. 

•	 If your database contained an excessive number of unfiled documents (several thousand), the Unfiled 
Document window stopped responding when you tried to delete a document. This has been fixed. 

LEDGER

•	 If you modified a column’s size and then selected two or more transactions, the rows were only 
partially selected. This has been fixed. 

•	 Adjustment type names longer than 30 characters caused the Ledger to stop responding. This has 
been fixed. 



	 Dentrix G6.4      7

Dentrix G6.4  Release Guide

•	 If you opened the Dental and Medical Insurance Claim windows for claims that contained diagnostic 
and cross-coded procedures, the windows incorrectly displayed columns and values. This has been 
fixed. 

•	 The Clear button in the Medical Insurance Claim Information dialog box was not active until you 
saved a procedure. This has been fixed. 

•	 Information in the Medical Insurance Claim Information dialog box was not cleared after you clicked 
the Clear button. This has been fixed. 

OFFICE MANAGER

•	 If you copied a Practice Analysis Report to an Excel spreadsheet, the Contract Analysis section 
appeared twice and Future Due Payment Plans and Payment Agreements appeared in the same row 
instead of separately. This has been fixed. 

PATIENT CHART

•	 Creating a clinical note without selecting a provider or by selecting an invalid provider caused an 
unhandled exception error. This has been fixed. 

•	 The Chart Notations icon and options were disabled if the workstation did not support 3D graphics 
and you tried to switch to the Chart view. You had to click the Refresh button to enable the Chart 
Notations icon and options. This has been fixed. 

•	 The Spell Checker incorrectly auto-corrected Clinical Note prompt names. This has been fixed. 

MISCELLANEOUS

•	 The Claims Tracking log contained usernames and passwords whenever you uploaded claims. This 
has been fixed. 

•	 The Time Clock Report allowed you to set an invalid date range (From date to a date after the To 
date). This has been fixed. 

•	 The Daily Huddle Report incorrectly contained Amount of Treatment Diagnosed/Accepted 
information for procedures flagged as mouth whether they were treatment-planned or not. This has 
been fixed. 
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Overview and New Features
This Dentrix G6.3 Release Guide provides information about the Dentrix G6.3 software release. This 
overview section includes important notes regarding the release, followed by a brief description of the 
new features and enhancements available in Dentrix G6.3.

Note: For information about using the new features in Dentrix G6.3, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6.3?” in the Dentrix Help. 
For information on installing Dentrix, refer to the Installation Guide.

New Features
Dentrix G6.3 includes the following enhancements:

APPOINTMENT BOOK

•	 The Scheduled Production Calendar now includes an Options button, which when clicked, opens the 
Appointment Book Productions Options dialog box. From this dialog box, you can select Use Total 
Charges from Practice Analysis (default) or Calculate with Production Adjustments. If you select 
Calculate with Production Adjustments, you must select either By Entry Date (when transaction was 
posted; displays total procedure and adjustment amounts) or By Procedure Date (you can change 
this date). The production amount includes production adjustments as set for the Practice Advisor 
Report, the Provider A/R Totals Report, and DXPort as well as completed procedures for the Calendar 
month for the providers selected for the current Appointment Book View. 

EDEX

•	 The Setup Wizard dialog box has been replaced by the eDex Settings dialog box. The text in the 
eDex Settings dialog box has been modified to more clearly explain how enabling lock in eDex works 
in conjunction with Dentrix passwords. 

EPRESCRIBE

•	 The City text box was limited to 20 characters, which resulted in an error message if the character 
limit was exceeded and you were unable to write prescriptions. The text box was modified to accept 
more than 20 characters. 

LEDGER

•	 The Edit or Delete Procedure dialog box has been modified to always allow the Override Dental 
Insurance Estimate to be updated or edited. Currently, this estimate can only be entered or edited 
before a procedure is attached to a claim or is moved to history. 

OFFICE MANAGER

•	 The Practice Advisor Report and Daily Huddle Report dialog boxes now allow you to select dentists 
only or hygienists only. 

•	 If Require Secure User Passwords is enabled and a user tries to log in with a blank password, a 
message appears stating that blank passwords are not valid and the Change Password dialog box 
will appear. 

•	 Dentrix now requires you to set up a new password administrator before you can inactivate a provider 
or staff member who is the last or only user to have the password administrator right. 

•	 The style used in the controls to select dentists and hygienists in the Practice Advisor Report dialog 
box was modified to match the style in the Daily Huddle Report dialog box. 
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•	 The Practice Advisor Report dialog box was modified to work the same way as the Daily Huddle 
Report dialog box when users select dentists or hygienists. 

•	 Route Slips now include patients’ mobile phone numbers. 

TREATMENT PLANNER

•	 The Practice Advisor Report has been improved to calculate the total revenues from treatment-
planned procedures more accurately. The Practice Advisor Report incorrectly included revenue totals 
from treatment-planned procedures based on when these procedures were completed rather than 
when they were accepted. The Practice Advisor Report also incorrectly included revenue totals from 
procedures that were never treatment planned. The report now excludes any procedures that were 
not treatment planned and diagnostic procedures and procedures for the “mouth” treatment area 
that were not treatment planned. 

MISCELLANEOUS

•	 You no longer have to add diagnostic codes separately for dental and medical insurance claims. 
You can now select either medical or dental diagnostic codes and Dentrix will add them to their 
respective claims. 

•	 The Help menu in all modules now contains a menu item entitled Dentrix Marketplace. 

•	 You can now press the F5 key to refresh any Dentrix module. 

•	 The Procedure Codes list in the Patient Chart now displays “Fewer Codes” instead of “Less Codes.” 

•	 The Copy Fee Schedule feature has been improved so that it no longer copies any ADA procedure 
codes that are outside the D0001 to D9999 range (conditions) or procedure codes that are in the 
[None] category (practices use the [None] category for inactive procedure codes). 

•	 You can no longer permanently disable Dentrix from automatically checking for updates by clearing 
the Automatically check for updates check box. This check box was removed from the Check for 
Updates dialog box. You can now suspend checking for updates in the Update Manager for a day, a 
week, or a month so that you can schedule updates during times more convenient to your practice. 

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of features and enhancements, refer to the Dentrix Help.

Appointment Book
Dentrix provides you with a calendar from which you can view production goals, scheduled production, 
and actual production, making it easy for you to quickly evaluate your progress in meeting production 
objectives. The calendar now includes an Options button that allows you to select how Dentrix calculates 
production amounts.

To view production using the calendar

1.	 In the Appointment Book, click the Calendar button.

The Calendar dialog box appears.

2.	 Click Scheduled Production.

The calendar view changes to show production figures and variances.
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3.	 Click the Options button.

The Appointment Book Production Options dialog box appears.

 

4.	 Select one of the following options, and then click OK:

•	 Use Total Charges from Practice Analysis – (Default) Calculates production from the total charges 
in the Practice Analysis Report.

•	 Calculate with Production Adjustments – Calculates production from the total charges and 
production adjustments as set in the Practice Advisor Report, A/R Totals Report, DXPort, and 
completed procedures for the month for the selected providers. Select one of the following 
options:

•	 By Entry Date – Calculates totals based on when transactions were posted.

•	 By Procedure Date – Calculates totals when procedures were scheduled.

5.	 To return to the calendar’s default view, click Scheduled Production.

Office Manager
The Practice Advisor Report and Daily Huddle Report dialog boxes now allow you to select dentists 
only or hygienists only. The look and feel of the dialog boxes were also modified and updated. For more 
details, see “Running the Practice Advisor Report” and “Running the Daily Huddle Report” in the Dentrix 
Help.
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Note the addition of the following buttons that replaced the All check boxes in previous versions of these 
dialog boxes. 
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What’s Changed?
The list below contains the fixes and changes that have been included in the Dentrix G6.3 release.

APPOINTMENT BOOK 

•	 You could open the More Information dialog box from the File menu even though you hadn’t 
selected an appointment. This has been fixed. 

•	 Archived patients appeared in the Daily Huddle Report as family members without a future 
appointment. This has been fixed. 

•	 Setting leap day (February 29) as a holiday generated year, month, and day errors in the Daily Huddle 
Report. This has been fixed. 

•	 The Scheduled Patient Summary Report sorts alphabetically regardless of the sort order you selected. 
This has been fixed. 

•	 If an appointment on the Pinboard was moved on a workstation other than the one the appointment 
was created on, the wrong patient was associated with the appointment on the first workstation. This 
has been fixed. 

•	 If you edited an event, the changes were not distributed automatically to all workstations until you 
moved the event, changed its status, or refreshed each workstation manually. This has been fixed. 

•	 You could not break two appointments that started at the same time for the same patient. This has 
been fixed. 

•	 The prompt to keep appointments on or to remove them from the pinboard did not appear when the 
Appointment Book was closed. This has been fixed. 

•	 You could not archive patients if you had too many broken appointments. This has been fixed. 

•	 The Prov text box in the Appointment Information History dialog box was sometimes left blank when 
you edited notes multiple times in the Appointment Information dialog box. This has been fixed. 

•	 The Hover window remained open and multiple Appointment Book icons appeared in the task bar if 
you rapidly moved the cursor outside the Hover window’s border. This has been fixed. 

•	 The date in the Created text box of the Appointment Information dialog box doesn’t change when 
you click the Schd Next button to create a new appointment. This has been fixed. 

•	 The year in the title bar of the Appointment Book Day Note dialog box was cut off. This has been 
fixed. 

•	 When you clicked the Delete Appointment/Event toolbar icon without selecting an appointment or 
event, a message appeared reading, “No appointment selected!” The message has been modified 
to read “No appointment or event selected.” 

•	 The Update Operatory Schedules option in the Set Time Limits dialog box disappeared if you 
opened a second instance of the Schedule Calendar for Practice dialog box. This has been fixed. 

•	 In the Print Appointment Book View dialog box, if you deleted (rather than selected [none]) the 
text from the lines under Appointment Display Info and then tried to print or batch the view, an 
unhandled exception occurred. This has been fixed. 

•	 If patients had more than 90 appointments, the line dividing past and future appointments no longer 
appeared in the Family Appointment List dialog box. This has been fixed. 

DOCUMENT CENTER

•	 An error occurred when you clicked the Add Journal Entry button in the More Information dialog 
box. This has been fixed. 

•	 Some multiple-page TIFF files displayed only the first page when they were imported into the 
Document Center. This has been fixed. 
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FAMILY FILE

•	 If you created a patient alert for a patient and then moved that patient to another family, the Patient 
Alerts icon was white instead of red and the alert appeared with the original guarantor. This has been 
fixed. 

•	 You could not save changes to a medical alert if you dated the consent date in the future. This has 
been fixed. 

•	 Could not add or edit a patient’s medical alert if the patient had a future first visit date set for a year 
or more in the future. This has been fixed. 

•	 If you deleted a billing type in the Office Manager and then selected one of the remaining billing 
types as a replacement, the replacement was not selected in the Family File. This has been fixed. 

•	 You could not enter or edit family members in the Edit Family Relations dialog box. An error 
message falsely indicated that claims were open. This has been fixed. 

•	 The Always Print Patient Information option under Advanced Options in the Claim Setup dialog box 
didn’t have a tooltip. This has been fixed. 

•	 If you assigned a secondary insurance carrier to a patient and then closed and reopened the 
Insurance Information dialog box, the secondary insurance carrier appears as both the primary and 
secondary insurance carriers. This has been fixed. 

•	 The automatic chart numbering feature does not track chart numbers assigned manually and so tries 
to reuse them. This resulted in an error message. This has been fixed. 

LAB CASE MANAGER

•	 If you filtered by a single patient, the results were inconsistent, sometimes returning multiple patients, 
sometimes a single patient. This has been fixed. 

LEDGER

•	 When you entered several insurance payments, the Ledger was slow. This has been fixed. 

•	 If you selected Auto-Create Secondary Claim with Primary Payment and Prompt to close claims 
without Assignment of Benefits in the Insurance Payment Setup dialog box, a secondary claim was 
not created. This has been fixed. 

•	 In the Batch Insurance Payment Entry - Check dialog box if you selected Split Adjustment by 
Provider and changed the adjustment type to Write-Off (-), you could edit the Total Amount text 
box. This has been fixed. 

•	 The FIFO (First In First Out) split payment type was not calculating split amounts correctly. This has 
been fixed 

•	 There were discrepancies between the provider balances in the Total Insurance Payment and 
Allocate Credit Balance dialog boxes for the same patient and procedures. This has been fixed. 

•	 If you assigned an adjustment type to a tax or a discount and then deleted the adjustment type, the 
tax or discount option was broken. This has been fixed. 

•	 Patient alerts did not appear when you entered a payment. This has been fixed. 

•	 Backdated procedures were not sorted correctly. This has been fixed. 

•	 Balances in the Allocate Credit Balance dialog box and in the Guar Est column of the Enter Payment 
dialog box (when splitting a payment) did not match for some patients. This has been fixed. 

•	 Claims were not sorted correctly if they were still outstanding after 2.5 years. This has been fixed. 

•	 When you created a pretreatment estimate, Dentrix set the insurance override to $0 until you deleted 
the pretreatment estimate or entered an insurance estimate. This has been fixed. 

•	 Walkout/Doctor’s Statements incorrectly printed insurance payments for patients who were not a 
head-of-household. This has been fixed. 
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•	 If primary and secondary insurance plans were the same, secondary insurance estimates weren’t 
being calculated after a secondary insurance claim was created. This has been fixed. 

•	 You could enter negative amounts in the Future Due Payment Plan dialog box. This has been fixed. 

•	 After submitting a batch or other transactions, the Ledger would scroll to the top of the transaction 
log. This has been fixed. 

•	 In the Enter Payment dialog box, if you entered a Bank/Branch # longer than 20 characters, an error 
message, “There was an error writing the payment(s),” appeared. This has been fixed. 

•	 If you entered a Claim Status Note and then split the claim, the note was deleted in both claims. This 
has been fixed. 

•	 An application error appeared if you closed the Ledger while a claim and the Remarks dialog box 
remained open. This has been fixed. 

•	 The Type list under Enter Adjustment was blank after selecting Write-Off (-) or Refund (+) in the Total 
Insurance Payment dialog box. This has been fixed. 

•	 If you changed the fee for a treatment-planned procedure that was attached to a pre-treatment 
estimate, the procedure appeared as “Accepted” in the Ins column of the Transaction Log. This has 
been fixed. 

•	 Cross-coding information in the Medical Claim Information dialog box was not saved unless you 
closed the Edit or Delete Procedure dialog box. This has been fixed. 

OFFICE JOURNAL

•	 If you added a new letter to the Office Journal and clicked the Show Info toolbar button, the entry for 
the new letter was blank. This has been fixed. 

OFFICE MANAGER

•	 You could not select archived patients for the Archived Patient List. This has been fixed. 

•	 If you removed a procedure code’s flags in the Surface Flags dialog box and saved your changes but 
didn’t close the Procedure Code Editor dialog box while the Ledger was open, those changes were 
not reflected in the Ledger. This has been fixed. 

•	 The Scheduled Production Analysis Report contained incorrect revenue totals and scheduled hours 
numbers. This has been fixed. 

•	 The Practice Advisor Report contained the incorrect number of hygienist production days. This has 
been fixed. 

•	 The “What’s new in Dentrix G6” Help topic was modified because it incorrectly stated that Route 
Slips had been modified to include a patient’s email address and mobile phone number. 

•	 The Sending to Dentrix Document Center message box appeared when you printed the Aging 
Report even though you were not  sending the report to the Document Center. This has been fixed. 

•	 If you selected the By Largest to Smallest Balance sort option and the Calculate Aged Balance as 
of option in the Aging Report dialog box, the total in the Current column of the Aging Report was 
incorrect. This has been fixed. 

•	 If you set the Minimum Days Past Due to Over 30 and the Sort Options to By Over 90 to Current 
Balance in the Aging Report dialog box, the last statement date was missing from the Aging Report. 
This has been fixed. 

•	 You could add an adjustment type without entering a plus (+) or a minus (-) sign. This has been fixed. 

•	 If you selected By Over 90 to Current Balance under Sort Options in the Aging Report dialog box, 
the insurance estimate total was $0.00. This has been fixed. 

•	 Instead of opening a warning message, Dentrix did not save your changes if you set the Interval in 
the Edit Continuing Care Type dialog box to 0 or to a number greater than 180. This has been fixed. 
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•	 Adjustment Types with long names did not appear correctly in the Adjustment Only Daysheet. This 
has been fixed. 

•	 Generating batch insurance claims for some providers created claims that were missing procedures. 
This has been fixed. 

•	 You could not print to the Microsoft XPS Document Writer from the Print Preview dialog box. This 
has been fixed. 

•	 The Edit button in the Referral Maintenance dialog box did not work if the pre-loaded referral table’s 
RefID in the database was a negative number. This has been fixed. 

•	 Changing the patient range of a billing statement in which you selected printing payment 
agreements only changed the balance due. This has been fixed. 

•	 Running a recalculation after exporting the database changed the amount in the Payment Agreement 
portion of the Practice Analysis. This has been fixed. 

•	 If you printed a Patient Notes Report for Clinical Notes and the clinical note exceeded 3981 
characters, the report stopped printing and an error message appeared stating that “Dxprint.exe has 
stopped working.” This has been fixed. 

•	 If a patient had multiple appointments on the same day, Dentrix generated an appointment reminder 
card for the appointment you created first instead of the appointment having the earliest time. This 
has been fixed. 

•	 In the Aging Report, the Calculate Aged Balance As Of option was not calculating the aged balances 
correctly. This has been fixed. 

•	 If you moved a family member from a family to his or her own family in the Family File and then 
filtered the Patient List by patient name, the list still contained the family member you moved. This 
has been fixed. 

•	 In the Preauthorization Aging Report, the wording for setting the provider filter (Select Provider) 
differed from the Insurance Claim Aging Report (Select Primary Provider). This has been changed to 
be consistent with the Insurance Claim Aging Report. 

•	 If you posted duplicate procedures (D4381), the procedures did not combine on the claim in the 
Batch Processor. This has been fixed. 

•	 If you exported a fee schedule, saved it as a .csv file, and then opened it in Excel, the fees and 
descriptions were not separated into the correct columns. This has been fixed. 

•	 Family payments were missing from deposit slips even if you had not selected the Combine Family 
Payments option. This has been fixed. 

•	 The payment amount differed in the Practice Analysis Report depending on whether you filtered the 
production summary by category or processor code range. This has been fixed. 

•	 If the number of staff members was at the maximum allowed, you could not edit them and instead 
received an error message, “No additional staff members can be added.” This has been fixed. 

•	 If you exported several fee schedules as comma delimited files without closing the Fee Schedule 
Setup dialog box, fees were duplicated in the comma delimited files. This has been fixed. Multiple 
patients appeared in the Patient List if you were printing Chart Labels even though you only selected 
one patient to print a label for. This has been fixed. 

•	 If you verified Billing Statements prior to sending and copying them to the Document Center and 
then posted procedures to another patient that passed through the Billing Statement filters, the 
text of the patient information and procedures overlapped in the statement and the patient’s Billing 
Statement was copied to another patient. This has been fixed. 

•	 Splitting payments changed the date on deposit slips. This has been fixed. 

•	 You could not print the Audit Trail Report as a text file. This has been fixed. 
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PATIENT CHART

•	 If you changed flags and added a procedure with a range of teeth, you received an “Invalid Range” 
error message. This has been fixed. 

•	 Paint types for conditions overrode completed procedures paint types. This has been fixed. 

•	 A Security Update for Windows Kernel-Mode Drivers: May 10, 2016 broke notations in the Edit Chart 
Notations dialog box. This has been fixed. 

•	 An “Unhandled Exception: Key Not Found” error occurred when you edited a procedure attached to 
a deleted multi-code from a procedure button set. This has been fixed. 

•	 If you copied a patient’s Progress Notes to the Clipboard and then pasted them to Excel, the data 
appeared in the wrong columns, and the columns were not in the correct order. This has been fixed. 

•	 If you opened a condition in the Progress Notes panel, you could only paste text into the Notes 
text box in the Change Conditions/Diagnosis dialog box by pressing Ctrl + V, and the copied text 
appeared in bold-faced type. The Copy/Paste context menu would not appear if you right-clicked the 
mouse. This has been fixed. 

•	 You could not open the Perio Chart if you double-clicked a perio exam in the Progress Notes panel. 
This has been fixed. 

•	 Clinical Notes in the Progress Notes panel were not sorted correctly when you clicked the Default 
Sort toolbar button. This has been fixed. 

•	 If you created a new provider and a new patient and assigned the new provider as the primary 
provider for the new patient, you could create a Clinical Note for the new patient even though the 
new provider did not appear in the providers list. This has been fixed. 

PRESCRIPTIONS

•	 You could not enter the acronyms for measurements such as milliliters (ML) or milligrams (MG) or 
decimal numbers in the Disp text box in the New Patient Prescription dialog box. You could only 
enter a whole number that represented the number of pills to distribute. This has been fixed. 

•	 When you clicked the Refill button in the Patient Prescriptions dialog box, the prescription date was 
not updated. This has been fixed. 

•	 In multiple state forms, graphical and textual X’s appeared in the Quantity check boxes instead of 
one or the other. This has been fixed. 

•	 The Prescriptions Report was not filtering correctly. This has been fixed. 

•	 The header in the Prescriptions Report displayed an invalid range (<All> - <All>) when the range 
should have been for a single patient. This has been fixed. 

•	 A usage error in an error message has been addressed. 

•	 When you used the New Jersey State Form 2014, text in the Sig text box in the New Patient 
Prescription dialog box did not wrap properly. This has been fixed. 

QUESTIONNAIRES

•	 The spell check button overlapped the Response List text box. This has been fixed. 

TREATMENT PLANNER

•	 The Practice Treatment Case Report included cases outside the date range and patients without 
treatment plans. This has been fixed. 

•	 An unhandled exception occurred if you clicked Case Presentation Setup and then opened the 
Presenter. This has been fixed. 

•	 The deductible amount was incorrect if you overrode the primary insurance amount in a pre-
treatment estimate and printed the treatment plan having turned off Use Dental Plan Maximums and 
Deductible. This has been fixed. 
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•	 A null reference exception appeared when you tried to open the Welcome Page Setup dialog box in 
the Presenter. This has been fixed. 

•	 Clicking the Insert Dateline button inserted the dateline in the upper left corner of a case note 
instead of at the insertion point. This has been fixed. 

•	 The Estimated Guarantor Portion amounts in Insurance/Case Amounts and Case Detail did not 
match. This has been fixed. 

•	 If you printed a treatment case for a patient without insurance, what printed in the Totals text box 
differed from one version of Dentrix to the next. This has been fixed. 

•	 If you deleted a case and then tried to recreate the case, an unhandled exception error occurred. This 
has been fixed. 

MISCELLANEOUS

•	 The Register Now dialog box was easily bypassed. This has been fixed. 

•	 If you tried to open ePrescribe from Windows Explorer, you received an error message reading, 
“Invalid Command Line (2112).” The message has been modified to read, “This application must be 
run from within your practice management software.” 

•	 Long clinical notes scrolled automatically due to the Spell Checker software. This has been fixed. 

•	 If you enabled Auto Spell Check for clinical notes, long clinical notes loaded slowly. This has been 
fixed. 

•	 If you opened the DXweb toolbar and minimized it to the task bar, when you opened it again from 
the task bar, it no longer has precedence over any other modules, dialog boxes, and so forth. This has 
been fixed. 

•	 When you searched for a patient in the Select Patient dialog box, the patient’s name appeared briefly 
and then disappeared. This has been fixed. 

•	 If the server’s name started with a hyphen, the server admin utility and export would not work. This 
has been fixed. 

•	 In the Time Clock, an unhandled exception occurred if you added or removed punches and 
exceeded the16 slots allocated for the day. This has been fixed. 

•	 Probing depths were missing from perio exams attached to insurance claims. This has been fixed. 

•	 If you submitted a claim, opened the Practice Information dialog box, and then reopened and 
resubmitted the claim, an error message, “Report file open at another workstation” appeared. If you 
clicked the error message’s Cancel button, a new claim entry was created in the Batch File. This has 
been fixed. 

•	 If you selected the 24-hour clock in Time Clock, Dentrix recognized 12:15 PM and 00:15 as the same 
time instead of recognizing 00:15 as 12:15 AM. This has been fixed. 

•	 Time Clock failed to open if you set up a Time Clock Report, saved the report by clicking the Save as 
Default button, closed Time Clock, and then changed a provider’s Provider ID. This has been fixed. 

•	 If you clicked the History tab in Time Clock and tried to set a date range in which the From date was 
one week prior to the current date and then from the To date list clicked the Back One Month arrow, 
the From date changed and graphical artifacts appeared in the Time Clock dialog box. This has been 
fixed. 

•	 Changes made to appointments through DDP were missing user IDs in appointment history. This has 
been fixed. 

•	 An error message appeared when running the Check Address utility because of a limitation in the 
Maintenance utility. This has been fixed. 

•	 ePrescribe does not recognize changes made to provider IDs. This has been fixed. 

•	 The Server Admin utility was not displaying the correct UNC path. This has been fixed. 
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•	 The Update Manager did not ignore a selected update for the amount of time the user specified. This 
has been fixed. 

•	 In some instances, Verify Files did not copy the correct files. This has been fixed. 
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Overview and New Features
This Dentrix G6.2 Release Guide provides information about the Dentrix G6.2 software release. This 
overview section includes important notes regarding the release, followed by a brief description of the 
new features and enhancements available in Dentrix G6.2.

Note: For information about using the new features in Dentrix G6.2, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6.2?” in the Dentrix Help. 
For information on installing Dentrix, refer to the Installation Guide.

New Features
Dentrix G6.2 includes the following new features and enhancements:

DOCUMENT CENTER

•	 Added a new DLL to improve the compression of scanner images.

QUESTIONNAIRES

•	 The design and layout have been improved. You can now view and fill out questionnaires without 
having to change pages excessively.

•	 You can more easily update your patients’ information in the Family File with their responses to 
questionnaire forms. The information from a questionnaire form and from the Family File appear side-
by-side in the Questionnaires module.

•	 Questionnaires now uses forms in HTML format instead of Flash. Those users who are on eCentral 
and use online forms will need to perform a websync to upload the new forms. Before performing a 
websync, users need to make sure they select the Questionnaires option to upload the HTML forms. 
These forms will provide users with a much more flexible and robust environment in which to create 
custom forms.

•	 Added Use larger text size check box to the Questionnaires Print Preview dialog box.

LEDGER

•	 You can now split payments manually more easily than in previous versions of Dentrix.

MISCELLANEOUS ENHANCEMENTS

•	 Set and alter the passphrase that Dentrix uses to connect to the Faircom database.

•	 Run Dentrix as a standard Windows user.

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of features and enhancements, refer to the Dentrix Help.

Passphrase
During the installation/upgrade process, you will be asked to provide a database passphrase. The 
passphrase will be required to install workstations and some software updates. We recommend that you 
store the passphrase in a secure location, such as an encrypted file, locked cabinet, or password storage 
program.

During installation the following dialog box appears asking you to enter a new passphrase.
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The passphrase must have the following charateristics:

•	 Be at least 10 characters long.

•	 Contain at least one capital letter.

•	 Contain at least one numeral.

•	 Contain at least one special character (asterisk, question mark, or other character).

1.	 Type the passphrase in the New Passphrase text box.

2.	 Re-type the passphrase in the Confirm Passphrase text box.

3.	 Select I have read the above statement, and then click OK.

Note: To see the passphrase as you enter it, select Show Passphrases. To review the requirements for 
the passphrase, hover your mouse pointer over the question mark icon.

Questionnaires
You can update patient information in the Family File based on Questionnaire response.

To update patient information in the Family File

1.	 In the Questionnaires Edit menu, click Update Patient Information.

The Update Patient Information dialog box appears with the name of the patient, the name of the 
form, and the response date in the title bar.
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2.	 In the upper left quadrant of the dialog box, select the category that you want to preview and 
update.

Note: A yellow square preceding the category signifies that the information in the questionnaire form 
differs from the information in the patient’s family file. A preview of the selected information appears 
in the From Questionnaire section. Any responses that are different from the information in the Fam-
ily File appear in yellow.

3.	 Do one of the following:

•	 To update the Family File with all of the information appearing in yellow, click the double chevron 
button.

•	 To update a single item in the Family File, select the item in From Questionnaire, and then click 
the single chevron button.

4.	 Click Update to update the patient’s Family File.

5.	 Click Close.

Dentrix saves the changes.

Ledger
Splitting patient payments manually is easier than in previous versions of Dentrix. The following example 
assumes that you don’t need to change any of the default settings.

To split a payment manually

1.	 In the Transaction menu in the Ledger, click Enter Payment.

2.	 In the Enter Payment dialog box, type the amount of the patient’s payment in the Amount text box, 
and if necessary, type the check number in the Check/Payment # text box.

3.	 Click Details.
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The Details panes appear in the Enter Payment dialog box.

4.	 To add a provider, click Add Provider.

5.	 From the Select Provider dialog box, select the providers you want to split the payment with, and 
click OK.

Note: To change the default payment priority, select the providers you want to pay first, and then 
click Give Payment Priority to Selected Item.

6.	 Double-click the provider amounts in the Pay column, and type the amounts that you want to pay 
each provider so that the Remaining Amount totals $0.00.

Note: The Provider Balances pane shows the patient’s account balance. The New Balance column 
lists the primary provider’s balance minus the amounts paid to any additional providers.

7.	 Click OK.

What’s Changed?
The list below contains the fixes and changes that have been included in the Dentrix G6.2 release.

APPOINTMENT BOOK 

•	 Scheduled daily production amounts were not updated if the amount charged for a procedure was 
modified. This has been fixed.

•	 Moving appointments to and from the Pinboard on more than one computer caused the most 
recently moved appointment to be selected on every computer. This has been fixed.

•	 When using the Medical Alerts/Notes option, users could enter notes that exceeded the 
appointment note field limit. This has been fixed.



6	 Dentrix G6.2

Dentrix G6.2 Release Guide

•	 Changing the amount charged for a procedure was not being saved if you created a route slip. This 
has been fixed.

•	 After restoring a database, you could not break or delete some appointments. This has been fixed. 

•	 The Appointment Book stopped responding when four procedures with the same continuing care 
were set complete. This has been fixed. 

•	 If you set a procedure to complete that contained multiple procedure codes including the D1110 
procedure code, the Appointment Book stopped responding. This has been fixed. 

DOCUMENT CENTER

•	 Images scanned using TWAIN or WIA were not being compressed regardless of the compression 
options selected in QuickScan or OEM applications. This has been fixed.

•	 Selecting a file path using the Browse button generated the following error: “Error exporting 
document.” This has been fixed. 

FAMILY FILE

•	 The Primary Dental Insurance window would not open for some patients. This has been fixed.

LEDGER

•	 Received an error when editing a $0.00 patient payment and adding a note to the payment. This has 
been fixed.

•	 Dates, names, codes, and descriptions were missing from some patients’ ledger entries. This has 
been fixed.

•	 Users received an error message after clicking Register for Electronic EOBs. This has been fixed.

•	 If you created a secondary claim on two computers for the same patient, two secondary claims were 
created. This has been fixed. 

•	 If you posted an adjustment that created a credit balance for the patient and family, the Ledger 
stopped responding. This has been fixed. 

•	 Box 9b (Reserved for NUCC use) in the HCFA 2012 form contained data when it should have been 
blank. This has been fixed. 

•	 If an AMA code contained more than six characters, box 24D in Medical Claims Forms was cut off. 
This has been fixed. 

•	 If you entered an itemized payment without updating the payment table and then tried to edit the 
claim, the amount of the itemized payment was replaced with the default amount from the payment 
table. This has been fixed. 

OFFICE JOURNAL

•	 Journal entries were attached to the wrong users. This has been fixed.

•	 If you selected single filters and added a journal entry, the folllowing error appeared: “Encountered 
an improper argument.” This has been fixed. 

OFFICE MANAGER

•	 The Daily Huddle Report incorrectly included completed procedure amounts in the Scheduled 
Remaining Month total. This has been fixed.

•	 Received the following error message after editing some procedure codes: “The ADA code has 
previously been entered and still exists.” This has been fixed.

•	 Printing payment agreements directly to a printer failed after upgrading. This has been fixed.
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•	 Inactivating a provider did not reassign all of that provider’s appointments to a new provider. This has 
been fixed.

•	 Changing the report font to bold did not change the entry in the BOLD text box to “Yes” in the 
Report Font dialog box. This has been fixed. 

PATIENT CHART

•	 Changing the Chart’s panel layout was not being saved until it was changed a second time. This has 
been fixed.

•	 Adding a clinical note template to a clinical note added two hard returns instead of one to the note. 
This has been fixed. 

•	 If you added a clinical note template to a clinical note, the text of the template appeared on top of 
the clinical note’s existing text. This has been fixed. 

•	 An unhandled exception occurred if you printed the Chart for a child who had at least one treatment-
planned procedure on a primary tooth. This has been fixed. 

PRESCRIPTIONS

•	 The last two digits of the year were missing from the Long Date Prescription Form. This has been 
fixed.

•	 The DEA number was missing from the Kentucky Standard Prescription Form. This has been fixed.

PRESENTER

•	 Closing and then re-opening the Presenter deselected the Auto-hide option. This has been fixed. 

•	 An error occurred if you moved panels and then closed and re-opened the Presenter. This has been 
fixed. 

QUESTIONNAIRES

•	 Printing from the Questionnaires module caused other modules on the screen to appear briefly on 
top of the Questionnaires window. This has been fixed.

•	 Page break incorrectly occurred between the question and selection lists. This has been fixed.

TREATMENT PLANNER

•	 If users didn’t use maximums and deductibles, the printed treatment case did not show the correct 
amounts. This has been fixed.

•	 The “Relationship to Patient” field was missing from consent forms. This has been fixed.

•	 If you printed a treatment case without including the patient’s secondary insurance, the fee schedule 
selected for Compare to Fee Schedule did not appear in the Totals text box. 

MISCELLANEOUS

•	 Users could not open medical alerts in some modules. This has been fixed.
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Overview and New Features
This Dentrix G6.1 Release Guide provides information about the Dentrix G6.1 software release. This 
overview section includes important notes regarding the release, followed by a brief description of the 
new features and enhancements available in Dentrix G6.1.

Note: For information about using the new features in Dentrix G6.1, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6.1?” in the Dentrix Help. 
For information on installing Dentrix G6.1, refer to the Installation Guide.

New Features
Dentrix G6.1 includes the following new features and enhancements:

ICD-10-CM CODES

•	 Dentrix G6.1 now supports the ICD-10-CM codes, so you can cross code to submit medical and 
dental claims. 

PRESCRIPTIONS

•	 The Prescriptions module has been redesigned. You can filter and sort the displayed list of 
prescriptions.

•	 Prescription form layouts are now stored as a separate file that can be updated without having to 
update Dentrix.

EPRESCRIBE

•	 If you use ePrescribe, you no longer have to enter prescription information in Dentrix manually. 
The patient’s information is downloaded from ePrescribe into Dentrix automatically when you close 
ePrescribe.

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of these features and enhancements, and others, refer to the 
Dentrix Help.

ICD-10-CM Codes
Dentrix includes an exhaustive medical insurance cross coding system that allows you to quickly bill 
both medical and dental carriers for the same procedures. Cross coding medical insurance allows you to 
flag certain dental procedures as billable to medical insurance and to cross-code an ADA code with the 
appropriate AMA-CPT, ICD-9-CM, ICD-10-CM, Modifier, and Service codes. In addition, Dentrix lets you 
cross-code ICD-9-CM and ICD-10-CM diagnostic codes with their corresponding AMA code.

Important: Due to licensing issues with the American Medical Association, Dentrix does not come pre-
loaded with the AMA-CPT codes. Instead, you can add these codes and then link the ADA code with its 
AMA code counterpart manually. You can get information on the codes and descriptions using reference 
books provided by the AMA. Please contact your local chapter of the AMA for assistance. Or, you can 
purchase the Cross Coding DataPak, which adds all of the codes and links for you. Please contact Dentrix 
at 1-800 DENTRIX (1-800-336-8749) for more information on obtaining the DataPak.
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To cross-code an ICD-10-CM diagnostic code with an AMA code

1.	 From the Maintenance menu in the Office Manager, point to Practice Setup, and then click Medical 
Cross Coding Setup.

The Medical Cross Coding Setup dialog box appears.

2.	 Click the AMA-CPT to ICD-10 Diagnostic Cross Coding tab.

All available AMA codes appear in the Select AMA-CPT Code list.

3.	 Do one of the following:

•	 Type the appropriate AMA code in the Select AMA-CPT Code field.

•	 Select the appropriate AMA code from the list.

If you installed the Cross Coding DataPak, the ICD-10 diagnostic codes associated with the AMA-
CPT code you selected appear in the Included ICD-10 Diagnostic Codes for AMA-CPT Code: 
[code] list.

4.	 To add any other applicable ICD-10 diagnostic codes, do one of the following:

•	 Type the appropriate ICD-10 code in the Available ICD-10 Diagnostic field, and then click Add.

•	 Select the appropriate ICD-10 code from the Available ICD-10 Diagnostic list, and then click 
Add.

The ICD-10 code you selected appears in the Included ICD-10 Diagnostic Codes for AMA-CPT 
Code list.

5.	 When you have finished cross coding, click Close, and then click Yes to save the changes.

Prescriptions
Dentrix helps you quickly create and accurately track your patients’ prescriptions. To set up and use 
prescriptions, you must first set up and define each prescription type and then set up a printer and 
customize the printer defaults. You can also edit or delete prescription types. Once you have set up and 
defined your prescription types and set up your printer, you can create and print prescriptions and refills 
for your patients. If you register for ePrescribe, you can create prescriptions and refills electronically.

To create a prescription for a patient

1.	 From any Dentrix module except the Office Manager, select a patient.

2.	 Do one of the following:
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•	 In the File menu, point to Switch To, and then click Prescriptions.

•	 In the module’s toolbar, click the Prescriptions button.

The Patient Prescriptions dialog box appears.

Note: The Patient Prescriptions dialog box consists of the following six columns:

•	 NS – A check mark indicates that the prescription is not a standard one. A change was made to 
the default prescription type.

•	 eRx – A check mark indicates that the prescription was imported electronically from the Allscripts 
database.

•	 Date – Indicates the last date the prescription was prescribed.

•	 Description – Indicates the prescription type, name, and standard dosage.

•	 Drug Name – Indicates the prescription name and the prescribed dosage.

•	 Prescriber – Indicates who prescribed the prescription (DDS1, DDS2, and so on).

3.	 Click New.

The New Patient Prescription dialog box appears.

4.	 If necessary, change the date to a date prior to the current one.

5.	 From the Description list, select a prescription type.

The remaining fields fill in automatically.
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6.	 You can customize the prescription information for the patient using the following fields:

•	 Drug Name – To modify the drug’s name.

•	 Sig – To change the dosage interval and instructions.

•	 Disp – To change the amount to dispense.

•	 Refills – To change the number of times a prescription can be refilled.

•	 Dispense as Written – To limit the prescription to the specified drug.

•	 Generic Substitution Permitted – To substitute a generic drug for a brand name one.

•	 Notes – To provide more thorough patient instructions. Click the spell check button to check the 
spelling of the note text.

7.	 From the Prescriber list, select the provider who is prescribing the drug.

8.	 Click Print to print the prescription.

The prescription prints to the printer you selected in the Prescription Setup dialog box, and Dentrix 
adds the prescription to the list of patient prescriptions in the Patient Prescriptions dialog box.

What’s Changed?
The list below contains all the fixes and changes that have been included in the Dentrix G6.1 release.

APPOINTMENT BOOK 

•	 The appointment note icon appeared when printing the Appointment Book View, even if the View 
Appt. Notes option was cleared. This has been fixed.  

•	 The New Patient Information dialog box appeared every time you made a new appointment for a 
patient. This has been fixed. 

•	 If a patient’s name exceeded 31 characters, the New Patient Information dialog box cut off the last 
five characters of a patient’s first name and the patient’s middle initial. This has been fixed. 

•	 The lab case icon did not update correctly on the appointment block. This has been fixed. 

•	 Appointments were not purged from the Unscheduled List. This has been fixed. 

•	 The appointment history was not in chronological order if the appointment was moved to the 
Pinboard. This has been fixed. 

•	 An appointment could be broken even if the patient’s file was open. This has been fixed. 

•	 The Appointment History List did not track who changed an appointment correctly. This has been 
fixed. 

•	 The Patient Visit Form held the last patient in memory until the module was re-opened. This has been 
fixed. 

•	 Appointment descriptions now include quadrant information. 

•	 Moving an appointment to the Pinboard caused the appointment date to change to 3/21/1700. The 
appointment date does not change now until the appointment has been rescheduled. 

•	 If an appointment’s description was blank, it could not be moved nor could you increase the length of 
the appointment by dragging the bottom or top edge of the appointment block. This has been fixed. 

•	 Phone and email information did not display properly in new patient appointments when you edited 
another new patient appointment. This has been fixed. 

•	 You can now click OK to close or move appointments that have inactive staff. 

•	 After upgrading to G6, an error occurred when you set continuing care appointments complete if the 
appointment was set in G5. This has been fixed. 
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DOCUMENT CENTER

•	 HTML files didn’t attach to the Document Center on multiple claim EOBs for insurance when “Find 
Claim” was used. This has been fixed.  

•	 Only the first page of multi-page TIFF files could be imported. This has been fixed. 

•	 The Printing to Document Center dialog box appeared when printing reports that weren’t being sent 
to the Document Center. This has been fixed. 

•	 If Microsoft Office was not installed on a workstation, Microsoft formatted documents appeared as 
blank windows instead of displaying “Unable to preview document.” This has been fixed. 

•	 If the Document Information dialog box was open and another module or application was opened, 
the Document Information dialog box remained hidden “behind” the other open items even after 
clicking the Document Center icon in the task bar. This has been fixed. 

FAMILY FILE

•	 In the Select Primary Dental Insurance Plan dialog box, if two plans had the same name, the first plan 
listed was selected by default rather than the patient’s insurance carrier. This has been fixed.  

•	 When you viewed an eligibility detail document in PDF, an Unhandled Exception Error occurred. This 
has been fixed. 

•	 The Family File stopped responding when you viewed eligibility status via eCentral. This has been 
fixed. 

LAB CASE MANAGER

•	 Once you set a lab case’s status to “Received,” you could not print the case. This has been fixed. 

•	 If you returned a case to the lab and printed out the prescription, the shades you selected before no 
longer printed. This has been fixed.  

•	 You could enter invalid data in the Lab Case Manager View if you clicked the OK button. This has 
been fixed. 

LEDGER

•	 After posting a denture procedure code (D5110), you could not choose a tooth number for additional 
procedures even if the tooth was not included with the denture. This has been fixed.  

•	 After closing and then re-opening Dentrix, the Add Provider button in the Allocate Credit Balance 
dialog box would not open the Select Provider dialog box. This has been fixed. 

•	 The Medical Insurance Claim Information dialog box didn’t save the insurance reference number. 
This has been fixed. 

•	 Dental diagnostic codes were not attached automatically if a procedure was treatment planned first 
and then set complete from an appointment. This has been fixed. 

•	 When a posted procedure had a medical cross code, dental diagnostic codes would not clear from 
the claim. This has been fixed. 

•	 Tooth numbers were not showing on medical insurance claims. This has been fixed. 

•	 The wrong payment amount was posted when the Post Claim button was clicked in the Batch 
Insurance Payment Entry - Electronic dialog box. This has been fixed. 
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OFFICE JOURNAL

•	 After selecting the HIPAA Privacy type, you could not change the type. This has been fixed.  

•	 Billing statement entries were not created if billing statements were generated for a date in the 
future. This has been fixed. 

•	 The Office Journal did not lock when the same document for the same patient was edited on two 
workstations simultaneously. This has been fixed. 

OFFICE MANAGER

•	 The number in the Referred Patients line in Practice Analysis is now calculated correctly.  

•	 If you selected the Self option for relationship to subscriber, the patient info box on the DX2012 
insurance claim form was blank. This has been fixed. 

•	 The Practice Advisor reported unscheduled hours incorrectly for providers without their own schedule 
and used the practice default schedule. This has been fixed. 

•	 Changing reports that were being previewed stopped DXPrint and removed reports from the batch. 
This has been fixed. 

•	 The CA Standard Form did not print correctly on preprinted paper. This has been fixed. 

•	 You could not generate billing statements for a range of patients. This has been fixed. 

•	 If you posted a charge or a debit insurance adjustment on a claim, the amount displayed in two 
places (Charge Adjustments and Charges Billed to Insurance) on the Day Sheet. This has been fixed. 

PATIENT CHART

•	 If you posted the D6750 procedure code to tooth 17 as a treatment plan and then posted D6750 to 
tooth 17 as existing other (EO) a tooth link was drawn on the right, even though a tooth wasn’t there. 
This has been fixed. 

•	 Primary teeth would not move or rotate in the Arch view when you selected mixed dentition. This has 
been fixed. 

•	 You could not delete Tx, Ex, or Eo procedures when the Enable Automatic Pre-Payment Allocations 
option was selected. This has been fixed. 

•	 The Print Treatment Plan Only option did not sort correctly. This has been fixed. 

•	 The Existing Other paint types were removed by an extraction paint type that was posted on the 
same day as the Existing Other paint types. This has been fixed. 

•	 The paint type for procedure code D6750 (bridge retainer crown) did not paint correctly if it was 
placed over an existing bridge retainer crown type. This has been fixed. 

•	 Sorting by tooth number was incorrect for tooth ranges. This has been fixed. 

PERIO CHART

•	 The number pad in the Data Entry panel did not work correctly when the numbers were clicked 
quickly.  

•	 Setting the Automatic Calculation option did not prevent entry settings. This has been fixed. 

PRESCRIPTIONS

•	 Long messages did not wrap in the Sig text box so the text overlapped other prescription form 
elements. This has been fixed.  

•	 If you restored a database from a backup made prior to setting up ePrescribe, you had to enter your 
GUID manually. This has been fixed. 

•	 The Description and Name fields are now limited to 50 characters. 
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QUESTIONNAIRES

•	 “Neither/Not Applicable” responses were not accepted when questions were set to Required. This 
has been fixed.  

•	 The preview in Questionnaires was sometimes blank when other modules were opened. This has 
been fixed. 

•	 The email address field is now limited to 60 characters. 

•	 You could leave the First and Last name fields blank in the New Patient Forms screen in the Practice 
website if you pressed the space bar. This has been fixed. 

•	 Patients’ previous responses were not displayed in the Preview panel when a form was updated to a 
new version. This has been fixed. 

•	 If you cleared the Include Practice Information option in the Questionnaire Form Setup dialog box 
and changed the Response Type to None, a comma appeared in the top left corner instead of the 
office address. This has been fixed. 

REPORTS

•	 The patient’s name was missing from the Provider Credit Report when the Credit Aged Balance as of 
option was selected. This has been fixed. 

•	 The beginning balance on the Provider AR Totals Report was not figured correctly for selected billing 
types. This has been fixed. 

•	 The Current Aging Bracket on the Aging Report was incorrect if you selected the By Largest to 
Smallest Balance sort option. This has been fixed. 

•	 The Daily Collections Report crashed if payment definition names began with an asterisk. This has 
been fixed. 

•	 The Treatment Case Report would not finish generating if a patient had linked alternate cases and all 
of the linked cases did not meet the severity requirement of the report filters. This has been fixed. 

TREATMENT PLANNER

•	 If you changed a completed procedure status to treatment plan, the Treatment Planner opened the 
procedure in the already completed case instead of the default. This has been fixed.  

•	 When you used two monitors to run a show in the Presenter, you could not move the show from 
monitor one to monitor two. This has been fixed. 

•	 Memory leaks occurred if the Insurance Case Note, Insurance Benefits, and Update Fees dialog 
boxes were opened and closed repeatedly. This has been fixed. 

•	 The Presenter would not print a treatment case for some patients. This has been fixed. 

•	 Insurance case amounts of alternate case plans were $0 in Treatment Plan Case Total. This has been 
fixed. 

•	 Page numbers were repeated when a treatment plan was printed from the Treatment Planner if an 
option such as Consent for Anesthesia was selected. This has been fixed. 

•	 The Pending Insurance Estimate YTD included outstanding claims from the previous year. This has 
been fixed. 

•	 An error occurred when you created multiple consent forms without closing the Edit dialog box. This 
has been fixed. 
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MISCELLANEOUS

•	 The Due Date Range in the Continuing Care List for patients without continuing care displayed 
incorrectly. This has been fixed.  

•	 Steps 11 and 12 were skipped in the Month-End Wizard Setup if you selected Full Form/Download as 
the billing statement form. This has been fixed. 

•	 You could not clear multiple Practice Analysis Reports that were set up during Month End Wizard 
Setup. This has been fixed. 

•	 A new merge token was added to represent the date/time of a selected appointment in addition to 
the current token that represents the date/time of the next appointment for the selected patient. 

•	 Send Message with Windows Live Mail did not work in 64-bit Windows 7. This has been fixed.  

•	 In the Continuing Care Display List, the Last Visit Date filter was not responding as expected. This 
has been fixed. 

•	 Creating a pre-estimate removed insurance override amounts. This has been fixed. 

•	 The Select Patient dialog box returned to the first name in the list when you scrolled to the bottom of 
the patient list. This has been fixed. 

•	 When a patient was archived, a WebSync update didn’t remove the patient from the family. This has 
been fixed. 

•	 The DXWeb, Referral Setup Password Security option did not work. This has been fixed. 

•	 The Select Patient dialog box did not sort appointment times correctly. This has been fixed. 

•	 The Invalid Range error message incorrectly appeared when you were setting a range for providers. 
This has been fixed. 

•	 In Box 24d of medical claims modifiers were printed in the incorrect order. This has been fixed. 

•	 Treatment planned procedures that were referred to a provider could be set to Completed instead of 
Existing Other. This has been fixed. 

•	 You could not archive patients who had two appointments at the same time in adjacent operatories. 
This has been fixed. 

•	 The simple Select Patient dialog box skipped patients when you searched by first name. This has 
been fixed. 

•	 Copying text from an Internet source, using the Paste from Clipboard option caused a claim/
attachment submission failure. This has been fixed. 
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Overview and New Features
This Dentrix G6 Release Guide provides information about the Dentrix G6 software release. This overview 
section includes important notes regarding the release, followed by a brief description of the new 
features and enhancements available in Dentrix G6.

Note: For information about using the new features in Dentrix G6, refer to “Using the New Features and 
Enhancements” in this section of the Release Guide or “What’s New in Dentrix G6?” in the Dentrix Help. 
For information on installing Dentrix G6, refer to the Installation Guide.

New Features
Dentrix G6 includes the following new features and enhancements:

ALERTS

•	 Medical alerts were enhanced so you can save medical alert notes in the notes history. You can copy 
medical alert notes to clinical notes, include medical alert notes in the Patient Notes Report, and add 
patient notes from Questionnaire forms to the medical alert note. 

•	 In the Create Patient Alert dialog box, a new “Questionnaires” option was added to the list of 
options where a patient alert could be displayed in Dentrix. 

APPOINTMENT BOOK

•	 Clicking an appointment outlines the appointment block in black so that it’s easier to see. Also, 
clicking an appointment block highlights the appointment time in yellow in the time bars. If you 
hover the mouse pointer over a time block, the time appears in the block. Tooltips were added to the 
provider columns, so you can tell at a glance which color is assigned to which provider. You also have 
the option of hiding the provider color columns from the Appointment Book view.

•	 The Enter New Patient Information dialog box was modified to include text boxes for a mobile phone 
number and an e-mail address. These changes appear in the More Information dialog box, the Hover 
window, and Route Slips and Patient View Forms.

•	 The order of the checks and message prompts that appear when you are scheduling appointments 
has been changed to be more logical.

•	 The following options were added to the Select View and the Print Appointment Book View dialog 
boxes: Mobile Phone, Other Phone, Email, Age, Birthdate, Primary Insurance, Guarantor Name, Appt 
Status, and CC Attached.

•	 When you schedule appointments, conflict warning messages no longer appear excessively.

•	 Now, when you purge appointments, you can also purge appointment history and events.

•	 When you create an appointment, you can now type a specific appointment length. 

•	 You can now specify an additional Provider ID for an appointment. You can also display this additional 
Provider ID field in the appointment block, Hover window, the Print Appointment Book View Report, 
the Patient Route Slip, and the Patient Visit Form.

•	 The Set Appointment Procedures Complete dialog box in the Appointment Book now allows you to 
view and easily assign providers to procedures before posting them. 

•	 Appointment blocks, the Hover window, the Appointment Information dialog box, and the 
Appointment History dialog box now include a Date/Time Created field and Staff ID field so you can 
see when the appointment was created and who created it. 

DOCUMENT CENTER

•	 Acquiring documents for the Document Center is even easier now. You can acquire documents using 
any type of device that supports the following outputs: .pdf, .doc, .docx, .xls, .ppt, .bmp, .gif, .jpg, 
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.png, .txt, and .rtf. Scanners no longer have to be WIA or TWAIN compliant. Further, you can now 
designate a folder that you can save images and documents to automatically regardless of the type 
of device you used to scan the image or document. If you want, you can disable the Auto Acquire 
feature.

•	 You can now rename Document Type Category names if they are attached to a signed document.

•	 The Document now notifies you when there are more than 40 unfiled documents.

LEDGER

•	 Several enhancements were made to the Ledger including new columns (Surface, Check #, N, R, D, 
M), adjustable column widths that are automatically saved when you close the Ledger, the ability to 
sort by and hide columns, a note indicator for payments and adjustments that have a note, tooltips 
for the column headings, alternate row shading, and a Refresh button on the toolbar. 

•	 When clicking Enter Batch Payments from the File menu, a new Batch Payment Entry dialog box 
appears with enhanced functionality.

•	 You can now split payments by multiple family members.

•	 When you click the Statement Notes button, a more detailed message now appears if you have 
exceeded the number of characters allowed in the Billing Statement Notes text box.

•	 The wording of the Check # field in the Enter Payment dialog box was changed to Check/Payment #.

•	 A new CMS 1500 Form was added to the Ledger. The instructions for completing the new claim form 
are available on the National Uniform Claim Committee (NUCC) website.

•	 If you have not selected Assignment of Benefits for a patient, you can now set an option in the 
Insurance Payment Setup dialog box to prompt users to post a $0 payment when the claim is created 
and close the pending claim.

•	 If a claim has not been created for today’s procedures, the estimates in the transaction log appear in 
red. A tooltip reminds office personnel to create a claim.

•	 In the Ledger Colors Setup dialog box, a new Restore Defaults button was added so you can restore 
the default Ledger colors. 

FAMILY FILE

•	 You can no longer archive a patient who has a credit balance.

•	 The Select Medical Alert dialog box now has an Insert Dateline button, so that you can insert a date 
in the Note text box.

•	 The Medical Alerts dialog box user interface has been improved.

LETTERS/LIST MANAGER

•	 You can use a new List Manager tool (similar to the one in Collections Manager and Treatment 
Manager) to create, view, and print customized lists of patient information. The List Manager also 
allows you to “hide” patients and merge letters for only the listed patients. 

•	 The Letter Merge feature includes a new option that allows you to open a data file in Microsoft Excel 
or Notepad. 

•	 The Patient Report View dialog box associated with the Office Manager’s Letters feature was 
redesigned to list all the available data fields in a single tree view. A new Select All option was added 
so you can select all data fields at once. A new Email option in this dialog box allows you to specify 
whether you want to include patients With Email addresses, Without Email addresses, or All. 

•	 A new data field was added where you can specify the date a patient last referred another patient. 

•	 The process of generating letters and lists is now simpler and requires fewer mouse clicks. It is more 
flexible when using data files and creating journal entries.
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OFFICE MANAGER

•	 In the Daily Huddle Report dialog box, you can use a new drop-down menu to specify whether you 
want to print/batch the Patient Visit Form or the Patient Route Slip.

•	 The Source of Payment list box in the Dental Insurance Plan Information and Medical Insurance Plan 
Information dialog boxes includes several new options that you can select.

•	 You can now sort the Patient List Report by family by family (guarantor and dependents).

•	 If opened from the Office Manager and if passwords are enabled, the Office Journal defaults to the 
staff member logged into Dentrix.

•	 Changes were made to the UB-04 Claim form to meet California Medicaid requirements.

•	 Peachtree 2000 was removed from the Export To list in the DXPort Setup dialog box.

PERIO CHART

•	 When you close a month, perio exams are now moved to History. Once you move a perio exam to 
History, it cannot be edited.

MISCELLANEOUS

•	 When you first open Dentrix, a “What’s New” message appears listing the new features added to 
Dentrix.

•	 Your Customer ID now appears in the About Dentrix dialog box.

•	 Processes, such as Month End, utilities, and the Month End Wizard, that require all Dentrix modules 
to be closed now display a list of all workstations with active modules and the names of the modules.

•	 The Dentrix logo has been updated and appears in the About Dentrix dialog box.

•	 Dentrix now includes a contact manager called eDex that lets you manage and quickly search for 
Dentrix contacts, such as patients, providers, staff, labs, insurance carriers, and other contacts. You 
can search by first or last name, address, email address, or phone number. You can also add custom 
notes or append notes to a patient note. A button to access eDex was added to the toolbars of most 
Dentrix modules; a button and graphic was also added to the Dentrix Launcher. 

•	 The toolbar buttons for all modules were given a newer look. The images below illustrate the changes 
in the Office Manager toolbar from Dentrix G5 to Dentrix G6 respectively.

•	 The Dentrix Launcher icon was modified.

•	 A Click to Chat button was added to all of the Help menus in the main modules.

•	 The Spell Checker software was updated.

•	 A new CMS 1500 Form was added to the Ledger. The instructions for completing the new claim form 
are available on the National Uniform Claim Committee (NUCC) website.

Using the New Features and Enhancements
The following information will help you understand how to use the features and enhancements in this 
release. For a more complete explanation of these features and enhancements, and others, refer to the 
Dentrix Help.
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Ledger
The Ledger includes several enhancements including new columns (Surface, Check #, N, R, D, M), 
adjustable column widths that are automatically saved when you close the Ledger, the ability to sort 
by and hide columns, a note indicator for payments and adjustments that have a note, tooltips for the 
column headings, alternate row shading, and a Refresh button on the toolbar. You can also split payments  
by multiple family members.

To split a payment by multiple family members

1.	 From the File menu in the Ledger, click Enter Batch Payments.

The Batch Payment Entry dialog box appears.

2.	 Click the Patient Name search button, and then select the appropriate patient from the Select 
Patient dialog box.

The Enter Payment dialog box appears.

3.	 Do the following:

•	 Date – (Optional) Type a date to change the procedure date from the current date.

•	 Payment Types – Select the appropriate type from the list.

•	 Amount – Type the payment amount in dollars.

•	 Check Number – Type the number, if applicable.

•	 Bank/Branch # – Type the number if you want it to appear on the Dentrix Deposit Slip.
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•	 Provider – (Optional) Select a provider from the list. (Default is to split the payment by provider.)

•	 Patient – Select Split By Family Members. (Default is to apply the payment to the selected 
patient in the Ledger.)

•	 Split Method – Select one of the following options:

•	 Percentage Payments – Divides the payment among the providers according to each 
provider’s percentage of the total amount owed.

•	 Guarantor Estimate – (Default) Applies the payment to providers who have balances as 
guarantor estimates and ignores provider balances that Dentrix estimates insurance will pay 
the remainder of.

•	 FIFO (First In First Out) – Applies the payment toward the oldest completed procedures first.

•	 Equal Payments – Splits payment amounts equally among all providers with debit balances.

•	 Details – Click to view payment details.

•	 Note – Type a note to document any unusual circumstances related to the payment.

•	 Apply To Payment Agreement – (Selected automatically if the account has a payment 
agreement.) Clear the option if the payment should not be applied to the payment agreement.

4.	 Click OK.

eDex
eDex is an electronic contact manager and directory to which you can attach patient notes. You can use 
eDex to manage and quickly search lists of patients (active, inactive, or archived), employers, insurance 
carriers, labs, non-patients, providers, staff, referrals, and any other contact you may want to remember. 
Using eDex, you can create custom contacts and contact categories to filter the Contacts List or even 
locate a patient’s next appointment.

To open eDex and add a contact

1.	 From the toolbar of any Dentrix module, click the eDex button.

The eDex window appears.
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2.	 From the eDex toolbar, click the New Contact button.

The Add New Contact dialog box appears.

3.	 Do one of the following:

•	 Category – Click the arrow and select a category from the list.

•	 Category Setup – Click the button and add a category.

4.	 Type the following Contact Information:

•	 Contact Name (Since Dentrix alphabetizes the patient list according to patients’ surnames, 
consider entering the contact’s surname followed by the contact’s given names when you are 
adding personal contacts.)

•	 Company Name

•	 Email Address

5.	  Type the following Address Info:

•	 Street 1

•	 Street 2 (If necessary)

•	 City

•	 State

•	 Zip

6.	 Type the following Phone Info:

•	 Preferred

•	 Work

•	 Fax

•	 Mobile

7.	 Click Save.

List Manager
You can use the new List Manager (similar to tools in the Collections Manager and the Treatment 
Manager) to create, view, and print customized lists of patient information. Using the List Manager you 
can also “hide” patients and merge letters for only the listed patients.

To create a letter using the List Manager

1.	 In the Office Manager menu, click Letters & Custom Lists.

The Letters & Lists dialog box appears.
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2.	 Click the button, such as Birthday, corresponding to the type of letter that you want to create.

A dialog box corresponding to the type of letter appears.

3.	 From the list, select the letter that you want to create, and then click Open List Manager.

The List Manager window appears.

4.	 In the toolbar, click Create Letters.

A message box appears.

5.	 Click Yes.

Dentrix opens Microsoft Word and creates a letter for every patient listed in the List Manager.
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Document Center
Acquiring documents for the Document Center is even easier now. You can acquire documents using any 
type of device that supports the following outputs: .pdf, .doc, .docx, .xls, .ppt, .bmp, .gif, .jpg, .png, .txt, 
and .rtf. Scanners no longer have to be WIA or TWAIN compliant. Further, you can now designate a folder 
that you can save images and documents to automatically regardless of the type of device you used to 
scan the image or document.

To set up auto file acquire

1.	 From the Acquire menu in the Document Center, click Auto Directory File Acquire.

The Setup Acquisition Method Defaults dialog box appears.

2.	 Use the following options to set up auto file acquire:

•	 Document Type – Select the appropriate type from the list.

•	 Description – Type a description of the document.

•	 Orientation – Select an orientation from the list. (Applies to X-rays and other images of a patient’s 
mouth.)

•	 Acquire without displaying Document Information – Select to prevent the Document 
Information dialog box from appearing.

3.	 Under Set Default Scanner Import Folder, click the search button.

The Browse For Folder dialog box appears.

4.	 Do one of the following, and then click OK:

•	 Select a folder.

•	 Click Make New Folder.
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5.	 From the Setup Acquisition Method Defaults dialog box, do the following:

•	 Combine Images Created within X seconds – Select the appropriate number of seconds you 
want to pass before Dentrix combines several images that you acquired simultaneously into a 
single document.

•	 Click Save and Close.

Appointment Book
From the Appointment Book, you can set procedures complete, post them to the Ledger, and set the 
patient’s next Continuing Care appointment. If necessary, you can now also set procedures complete and 
post them to the Ledger for more than one provider at a time.

To set appointment procedures complete for an additional provider

1.	 In the Appointment Book, select the appointment that you want to set the procedures complete for.

2.	 From the Options menu, click Post/Set Complete.

The Set Appointment Procedures Complete dialog box appears.

3.	 Select the procedure that you want to set complete for the additional provider, and then click Change 
Provider.

4.	 Select the additional provider from the sub-menu.

5.	 Click Post/Set Complete.

PROVIDER COLUMNS

You can now hide the provider columns from your view of the Appointment Book.

Hiding the provider columns

1.	 In the Appointment Book menu, click View.

2.	 From the Select View dialog box, click New.

The Select View dialog box appears.
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3.	 Clear the View Provider Columns check box, and then click OK.

Medical Alerts
You can now save medical alert notes in the notes history. You can also copy medical alert notes to clinical 
notes, include medical alert notes in the Patient Notes Report, and add patient notes from Questionnaire 
forms to the medical alert note.

To copy a medical alert note to clinical notes

1.	 In the Family File, select a patient.

2.	 Click the icon in the Medical Alerts block.

The Medical Alerts dialog box appears.

3.	 Click Edit.

The Select Medical Alerts dialog box appears.
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4.	 To add a note, type it in the Notes text box, and then click OK.

5.	 To copy the patient’s medical alert and any notes the patient’s clinical notes, click Copy to Clinical.

6.	 Click OK to save your changes, and then click Close.

What’s Changed?
The list below contains all the fixes and changes that have been included in the Dentrix G6 release.

APPOINTMENT BOOK 

•	 If you selected the Do Not Bill to Dental Insurance option for a head of household and then set 
an appointment complete for a member of the household who has his or her own insurance, the 
procedures are not billed. This has been fixed. 

•	 Clearing a procedure in the Set Appointment Procedures Complete dialog box did not prevent the 
procedure from being set complete. This has been fixed.

•	 The first digit in any field in the Account Guarantor text box of the Patient Visit Form was cut off if the 
patient had a large credit balance. This has been fixed. Completing a continuing care appointment 
did not advance days. This has been fixed.

•	 Clicking the Other Appts button goes to the day of the future appointment but does not highlight 
the appointment. This has been fixed. Archiving a patient does not remove the patient from the 
Unscheduled List. This has been fixed. The preview for the Hover Detail Setup dialog box now looks 
like the actual Hover window. Breaking an appointment changes the appointment’s creation date. 
This has been fixed. The Scheduled Patients Summary Report listed patients as having no future 
appointment even though they had appointments scheduled. This has been fixed. 

•	 When selecting treatment plan procedures for an appointment, the procedures are now grouped by 
treatment plan case. 

•	 If an appointment for an archived patient was selected when you opened the Ledger from the 
Appointment Book, an error message appeared. This has been fixed, and the error no longer 
appears.  

•	 When editing continuing care in the Family File, if you set the Total Time Units in the Appointment 
Time Pattern dialog box to a value greater than 17, Dentrix would not use that default time value 
when scheduling a continuing care appointment in the Appointment Book. This has been fixed. 

•	 After an appointment in the Appointment Book was set complete and you created a new 
continuing care appointment for the patient with certain settings (Allow Amount to be entered/
fixed was selected and Always Calculate was not selected), the Amount shown in the Appointment 
Information dialog box was not correct. This has been fixed.

•	 If you pressed an unassigned shortcut key (such as F5) when using the Appointment Book, the 
production amount (if displayed) would disappear in the top right corner of the Appointment Book. 
This has been fixed. 

•	 When an appointment that included two procedures set to all chair time (_) was created, the time 
intervals would be changed to all provider time (X). This has been fixed. 

•	 Adding a treatment-planned procedure to an appointment with non-treatment-planned procedures 
caused the time interval to change to all provider time (X). This has been fixed. 

•	 If you clicked Find in the Appointment Information dialog box to look for a new appointment time, 
the Find New Appointment Time dialog box did not remember the provider and operatory defaults 
from the original appointment. This has been fixed. 

•	 The month view in the Appointment Book did not display the office’s closed hours or days. This has 
been fixed.

•	 The Appointment Book allowed you to set complete future appointments. This is no longer allowed.  
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•	 The Appointment Book New Patient status did not automatically update when a new patient was 
added to a family using a different workstation than the one where the new patient appointment was 
added. This has been fixed. 

•	 After changing the date on a Flip Tab in the Appointment Book, clicking the Flip Tab didn’t take you 
to the new date. This has been fixed.

•	 When creating a new continuing care appointment and posting a multi-code, the reason for the 
appointment did not update using the description for the multi-code but was instead left blank. This 
has been fixed. 

•	 Purged appointments now appear in the Audit Trail Report. 

•	 If the Allow Amount to be entered/fixed option was selected in the Appointment Book, the correct 
dollar amount did not appear when creating the next continuing care appointment. This has been 
fixed. 

•	 When printing an Appointment Book view that included a linked event, the wrong icon (+) was used 
for the event. The correct “link” icon is now used. 

•	 When viewing the Hover Window for a patient with a patient picture, the Appointment Book would 
stop responding if the patient picture was unavailable (due to the patient picture file being deleted, 
moved, corrupted, and so on). This has been fixed.

•	 The Patient Visit Form would list future appointments in the order they were created, not in 
chronological order. The form now lists them in chronological order.

•	 Some customers would see the message “Operatory is already scheduled for requested time” 
when there was no visible appointment scheduled during the time they were trying to schedule the 
appointment. This has been fixed.

•	 When scheduling an appointment for a patient who had more than 26 treatment case visits 
scheduled, any treatment case visits over 26 would be numbered using letters of the alphabet (A, B, 
C, and so on). Numbers are now used. 

•	 The appointment history in the Appointment Book (and Appointment History List in the Office 
Manager) did not update with changes made after an appointment was completed. This has been 
fixed. 

•	 Creating a Day Note for the same day from two different Dentrix computers would cause the 
following message to appear when trying to save it on the second computer: “Another note was 
recently added for this claim at another workstation. This note cannot be saved.” Now a lock is 
placed on the Day Note message while it is open on one computer; if another Dentrix user tries to 
open and edit the Day Note, a message tells the other user that the Day Note is open on another 
computer.

•	 The More Information (Dial) menu item on the File menu is no longer enabled when an event is 
selected in the Appointment Book. 

•	 When eight or more operatories were displayed in the Appointment Book, and the View Time at 
Right option was selected in the Practice Appointment Setup, some of the time digits could overlap, 
causing 11:00 to appear as 1:00, for example. This has been fixed. 

•	 In the Provider Setup dialog box, you can now only assign up to twelve time blocks to a single 
operatory. 

•	 If a time block was manually moved to a new time and the time block series was subsequently 
deleted, the Appointment Book would not show the time block but continued to respond as if it was 
there when scheduling appointments (a message about a time block would appear when scheduling 
appointments during that time). This has been fixed, and the message no longer appears. 

•	 The appointment history would not track changes for any appointments scheduled using a version of 
Dentrix prior to G4 Productivity Pack 7. This has been fixed. 

•	 In the Appointment Book’s Hover Window, a label that read “SNN” (for Social Security number) has 
been changed to “SSN.” 
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•	 When a lock was placed on a practice resource (perhaps because it was being edited in the Resource 
Setup by another user), if a user tried to edit an appointment in that operatory, the message “Practice 
resource file open at another workstation” would appear, followed by “Invalid operatory ID.” These 
messages no longer appear.

•	 When dragging an appointment in the Appointment Book, if you pressed Alt+Tab to leave the 
Appointment Book and then released the mouse button, the appointment would be “stuck” to the 
mouse insertion point, causing several display issues in the Appointment Book. This has been fixed. 

•	 If an operatory was deleted, it still appeared as the default operatory selection in the Appointment 
Book’s Appointment Information dialog box. This has been fixed. 

•	 Appointment history now tracks new continuing care appointments that are moved from the 
Pinboard.

•	 If you closed the Appointment Book while a Continuing Care List was generating, a “global lock” 
error would appear. Dentrix now prevents you from closing out of the Appointment Book while the 
Continuing Care List is generating.

•	 The Continuing Care Attached field and Patient Pending Continuing Care dialog box in the 
Appointment Information dialog box now sorts entries by continuing care date, not alphabetically.  

•	 If you selected an appointment in the Appointment Book, clicked Find New Appointment Time on 
the Options menu, closed the Find New Appointment Time dialog box, changed the appointment 
length, and then re-opened the Find New Appointment Time dialog box, the appointment length 
would not update. This has been fixed. Continuing care types were not being sorted correctly in the 
Patient Pending C. Care dialog box. This has been fixed. 

•	 When moving an appointment in the Appointment Book, if the message “Provider is already 
scheduled...” appeared and you tried to open the patient information for that patient, a message 
would appear on multiple Dentrix computers indicating that a patient file was open at another 
workstation. This has been fixed. Closing the Appointment Book while the Continuing Care List 
loaded caused an error and locked the system. This has been fixed. Changing the operatory, time, 
or date of an appointment on the Pinboard did not change the operatory, time, or date in the 
Appointment Book schedule. This has been fixed. 

•	 “Ghost” appointments have been eliminated. 

•	 When trying to create a patient alert, the user received an error message stating that the current 
patient’s information was no longer valid and may have been edited at another workstation. This has 
been fixed. The Patient Visit Form did not print if the user selected All Patients and Today for a date 
range. This has been fixed. The Last Changed date was not updating. This has been fixed. 

•	 The lab case icon (blue L with white background) did not change when the lab case was received and 
the Appointment Book view was refreshed. This has been fixed. 

•	 Attaching procedures to appointments with Continuing Care attached doubled the length of the 
appointments. This has been fixed. 

CLAIMS

•	 When you send electronic claims, Dentrix now adds the status note “eSent” to the claim’s status 
notes section along with a time stamp. 

•	 A new setup feature allows you to put the primary insurance payment in the “Other Fee” area of the 
DX2007 and DX2012 forms, as requested by various carriers. This can help avoid rejected claims when 
this fee appears in the line item location, causing the sum of all line items to not equal the total fee 
amount.

•	 After adding secondary insurance to a claim, the DX2007 claim format would mark box 4 (has 
secondary coverage) but would not include the additional claim information needed in boxes 5-11 
until you clicked Update Secondary. Selecting box 4 without the other boxes filled in would cause the 
claim to be rejected. This has been fixed, and the additional claim information is now automatically 
updated.
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•	 If a patient had the same insurance plan for both primary and secondary insurance, a secondary claim 
wouldn’t show an insurance estimate. This has been fixed.

•	 The Insurance Ref # (specified in the Ledger’s Medical Insurance Claim Information dialog box) is 
now included on medical claims.

COLLECTIONS MANAGER

•	 If you displayed all collection results in the Collections Manager and then switched to a filtered 
view (one that excluded some payment agreements or future due payment plans, for example), the 
Collections Manager would display incorrect information for certain patients. For example, it would 
display information for a patient in the previous list as the information associated with the patient in 
the new filtered list. This has been fixed. The Collections Manager did not display the correct name 
list. This has been fixed. 

DOCUMENT CENTER

•	 Keyboard shortcuts were added to the Document Center’s Acquire menu.

•	 Received an error message when trying to print a rich text format (RTF) document. This has been 
fixed. 

•	 When exporting images from the Document Center, if you specified a different file type than the 
current file type, the Document Center would save the file using the specified file extension but 
would not convert the file to the new format specified. This has been fixed. 

•	 Could not preview images if they had different regional settings when they were imported. This has 
been fixed. 

•	 The Acquire from Device option was sometimes missing from the Document Center. This has been 
fixed. 

•	 The Document Center could import, export, and email HTML and XML files, but these file types could 
not be previewed or printed. This has been fixed. 

•	 If more than 40 items are present in the Unfiled Documents list when the Document Center is closed, 
a message now appears and gives you the option of opening the Unfiled Documents list. Problems 
that prevented you from printing documents from the Document Center tree to the Document 
Center printer driver have been fixed.

•	 Printing labels to the Document Center Printer using the 5160 mailing labels option would send 33 
labels instead of 30. This has been fixed. 

•	 Using the Combine option to merge two or more documents in Unfiled Documents caused the 
second document to display a gear until it was manually refreshed. This has been fixed. 

•	 Pasting text from Microsoft Word into the Document Center and then printing would cause an error 
message to appear. This has been fixed. 

•	 When attempting to export a document from the Document Center and replace an existing file with 
the same name, the Document Center would not replace the file. This has been fixed.

•	 If you set the Document Center Statement Count to a value that was less than the number of the 
actual number of billing statements being printed to the Document Center,  some statements did not 
appear correctly. This has been fixed. 

•	 Signing a document in the Document Center and then clicking Refresh would cause the Export 
button to become disabled. This has been fixed. 

•	 After setting the file attributes of a file in the Document Center to “Read-Only” or “Hidden,” the 
Document Center would no longer import PDF files. This has been fixed. The medical claim form now 
includes the medical procedures and medical fee schedule, rather than the dental procedures and 
dental fee schedule. 
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•	 A number of scanners set up to use WIA or TWAIN did not function properly. This has been fixed with 
the auto-acquire feature. Using this feature, you can have a scanner save supported file types (.jpg, 
.pdf, .bmp, .png, .doc, .xls, and so on) to a folder you specify. 

•	 The Send Document(s) and Export Document(s) options in the File menu are not available when an 
image is attached to a claim. This has been fixed. 

•	 Text files attached to claims incorrectly produced the “Attachment file . . . not found!” error message. 
This has been fixed. 

•	 The Document Center printer was not properly registered during installation. This has been fixed. 

•	 Received the error message “Error creating attachment” trying to acquire a PDF file automatically. 
This has been fixed. 

•	 Could not open the Document Center. This has been fixed. 

FAMILY FILE

•	 When deleting a patient, the Family File now checks to see if the patient record includes any signed 
documents, clinical notes, questionnaires, or Document Center Files and asks if you want to continue 
if any of these are found. 

•	 When selecting a Carrier under Select Primary Dental Insurance Plan in the Family File, if two plans 
had the same name, the first one listed would be highlighted by default (even if it wasn’t the one 
assigned to the patient). If you clicked the double-arrows next to Carrier and then clicked OK or 
pressed Enter, Dentrix would change the patient’s insurance to the default plan that was highlighted. 
This has been fixed. The Select Payor ID dialog box loaded slowly. This has been fixed. )

•	 The DX2007 claim format does not print all of the required Other Insurance fields (boxes 8 & 10) 
when patients have medical insurance. 

•	 When using the New Patient Appointment method to add a new patient, if you then added a 
family member with a Non-patient status to the family, Family File would record the additional family 
member as a family referral. Family File no longer records it as a referral.

•	 You can add more than 18 patients to a family when you archive some of the patients in the family. 
This has been fixed. 

•	 The error message, “Cannot open patient file” would appear when closing Family File if the Dentrix 
Help window was open. This has been fixed.

•	 If a long e-mail address (longer than 40 characters) is entered for a patient, the More Information 
dialog box now includes ellipses points (...) to represent the part of the e-mail address that is too long 
to appear in the field. 

•	 When using the Advanced Search tab in the Select Patient dialog box, you can now open the patient 
records for archived patients. 

•	 If Continuing Care was attached to an appointment in the Appointment Book, when you viewed the 
More Information dialog box in the Family File for that patient, the Provider field under Continuing 
Care would be blank. This has been fixed. 

•	 If you selected the Hide Social Security Number option in the Office Manager while the Family File 
was open, Social Security numbers weren’t hidden properly in the Family File until you closed and re-
opened the Family File. Closing and re-opening the Family File is no longer necessary to hide Social 
Security numbers. 

•	 If the Practice Resource Setup dialog box was open on any Dentrix computer when you tried to 
change patient information in the Family File, you would see a message stating that a resource file 
was open. (This scenario could also cause other error messages to appear.) If you cancelled the 
message, Dentrix would save your patient information changes anyway. The lock was unnecessary 
and the messages no longer appear in this scenario.

•	 Archived patients were listed in (and could be selected from) the Previously Selected Patient list, but 
their patient information could not be opened for editing. This has been fixed, and archived patients 
are no longer listed in the Previously Selected Patient list.
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•	 When printing a Referral Label from the Referral box in the Family File, no space was added between 
the doctor’s middle initial and last name. This has been fixed. 

•	 Could not simultaneously edit the same Continuing Care Type on different workstations for different 
patients. This has been fixed. 

•	 Could not update the coverage table when adding payment table entries. This has been fixed. 

•	 Using an upper case or a  lower case “D” in a procedure code allowed duplicate entries in the 
payment table. This has been fixed. 

•	 Patient Medical Alerts are now listed alphabetically in the Family File. The Do Not Bill to Insurance 
option in the Ledger was selected when the patient’s appointment was set complete even though 
that option was cleared in the Family File if the patient’s insurance was not the same as the 
guarantor’s. This has been fixed. 

LEDGER

•	 Status notes wouldn’t appear when you switched between medical and dental claims by clicking the 
View Medical or View Dental buttons. This has been fixed. 

•	 The Batch Insurance Payment Entry dialog boxes do not reset the deductible amount to zero for the 
next entry. This has been fixed. 

•	 Procedures were posted in reverse order. This has been fixed. 

•	 Could not create an insurance claim because could not open the Insurance Information dialog box. 
This has been fixed. 

•	 Insurance claim adjustments were posted to the wrong patient account. This has been fixed. 

•	 When opening a paid insurance claim, the Est Ins Portion displayed a “0.” This has been fixed. It now 
checks to see if the claim is paid and displays the estimate value that is stored in the claim record. 

•	 When the amount of a payment exceeded the current aging amount, the aging amount under MTD-
Cur in Receivables Analysis could add up to more than 100%. This has been fixed. 

•	 If Auto-Create Secondary Claim with Primary Payment and Auto-Receive Secondary Claim if No 
Pending Ins Estimate are selected and a primary insurance payment is entered, a secondary claim is 
always created with a $0.00 payment. This was fixed. 

•	 Procedures selected as Do Not Bill to Insurance appeared as an outstanding balance to insurance. 
Expected amount from insurance showed correctly as $0.00. This has been fixed. 

•	 The 24j, 31, 32, and 32a boxes in the CMS-1500 form were not being filled in correctly. This has been 
fixed. 

•	 You could change which patient to apply a payment to even though a procedure had been moved to 
history. This has been fixed. 

•	 Claims were rejected by Alaska Medicaid because box 27 in the DX2007 and DX2012 forms was not 
filled in correctly. This has been fixed. 

•	 If a Future Due Payment Plan was set up, charges were posted at month end even though a payment 
wasn’t due that month. This has been fixed. 

•	 The Audit Trail Report included an audit record for a split payment even if the payment was not split. 
This has been fixed. 

•	 When printing the Payment Agreement Coupon Books and the Payment books for the future due 
payment plans, Dentrix would truncate the name of the office after several letters. This has been 
fixed.

•	 When typing notes after double-clicking a procedure in the Ledger, if no claim was attached, you 
could press Enter to move to a new line. However, if there was a claim attached, pressing Enter would 
close the View Procedure Attached to an Insurance Claim dialog box but save what was typed. Now, 
pressing Enter always moves to a new line in the notes without closing the dialog box if it is open. 
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•	 The medical claim form now includes the medical procedures and medical fee schedule, rather than 
the dental procedures and dental fee schedule.

•	 If you began the process of posting an insurance payment in the Ledger, but then opened a different 
patient in the Ledger before clicking OK/Post to complete the process, when you subsequently 
posted the payment for the first patient, it would not post to the correct patient. This has been fixed. 

•	 Posting an additional payment to a claim already in history using the same check number would put 
the new payment into history also and combine it with the previous payment. Now, a new payment is 
added to the Ledger. 

•	 In the Billing/Payment Agreement Information dialog box, the Balance for PA amount would be 
different depending on whether the payment agreement was created in the Ledger or the Family File. 
If the Ledger was used, the Balance for PA amount would display the Family Portion of Balance. If 
the Family File was used, the Balance for PA amount would display the Family Balance. The field now 
displays the Family Portion of Balance regardless of where the payment agreement was created. 

•	 Sorting the Bank/Branch and Check # columns in the Search Payment dialog box (File > Search 
Payments) did not display correct sort results when a hyphen (-) was used in either of these fields. This 
has been fixed.

•	 When splitting an insurance claim that has already been batched, the status is now changed to 
Created for both claims instead of leaving the status set to Sent. 

•	 Posting a multi-code for the same patient on two different Dentrix computers at about the same time 
would cause the message “A necessary file is in use” to appear for a couple of minutes. This has 
been fixed. 

•	 The Do Not Bill to Dental Insurance option in the Procedure Code Editor dialog box is now reset if 
the posted code is changed. 

•	 Modifying the treatment area for procedure code D0220 could cause the procedure code to change 
to D0230 if it was re-selected. This has been fixed.

•	 If you deleted a claim and then used a different computer to modify a note on a procedure attached 
to the deleted claim, the Ledger would display the error message, “An Insurance Claim That Was 
Previously Created For This Procedure Cannot Be Found.” When this happened, the database would 
need to be repaired. This problem has been fixed. 

•	 When posting an insurance payment, if the Patient Information dialog box from the Family File 
was open for the patient, Dentrix would display a message saying that the patient file was open at 
another workstation. After clicking Cancel, this message would re-appear three more times, followed 
by a message saying that the patient information was no longer valid. The Ledger would then clear 
the selected patient information while leaving the claim open, post the insurance adjustment but not 
the payment, and leave the claim set to Sent. This has been fixed; the error messages and file locks 
work properly and only when needed. 

•	 When posting an insurance payment, if the Patient Information dialog box from the Family File 
was open for a subscriber, Dentrix would display a message saying that the patient file was open at 
another workstation. After clicking Cancel, Dentrix would display messages saying it cannot read 
the patient file. This has been fixed; the error messages and file locks work properly and only when 
needed. 

•	 For patients with no insurance, the Today’s Charges displayed correct totals for the guarantor but 
only displayed 0.00 for all dependents. This has been fixed.

•	 When attaching images to a claim using Dexis Integrator, if you double-clicked on the image button 
instead of single-clicking, the Ledger would stop responding. This has been fixed. 

•	 If the path to the Dentrix program files was C:\Program Files\Dentrix and a file with the name 
“program” existed in the root of the C: drive, the Month End Wizard would not launch. This has been 
fixed. 

•	 Dental diagnostic codes can no longer be selected in the Ledger’s Enter Procedure dialog box. 
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•	 The Split Payment options for Family set in Office Manager’s Preferences dialog box were not used 
in the Enter Payment dialog box when the Office Manager was set to run in Tutor mode. These 
options are now used when running in Tutor mode also.

•	 When using the DX2000 claim form, if the form included seven procedures and an insurance payment 
had been made, the claim would print a procedure twice. This has been fixed.

•	 If a patient had primary and secondary insurance with a primary insurance claim in the Ledger, if 
secondary insurance was cleared from the Family File, there was no way to update the primary 
insurance claim to reflect this change. This has been fixed. 

•	 Right-clicking a patient’s name in the Ledger’s Select Patient dialog box and using the Family 
Members shortcut menu to change the family member did not change to the selected family 
member. This has been fixed.

•	 In the Batch Insurance Payment dialog box, some Adjustment fields allowed you to type letters and 
still post the claim, which would result in an error. Dentrix now provides a warning as soon as you type 
the letters and leave that field. Dental claim payments did not appear on medical insurance claims for 
Blue Cross Blue Shield of Minnesota. This has been fixed. Payments now appear in box 29. 

•	 Orphaned claim estimates were incorrect. This has been fixed. 

•	 When you print a Walkout Statement and select the Print the Doctor Recommendation option, all 
supported versions of Word are now able to launch and print the document. 

•	 When printing a Walkout Statement with a Recommendation Document, Microsoft Word now closes 
after it has finished printing. 

•	 Clearing a patient’s secondary medical insurance information from the Family File did not clear that 
information from the patient’s primary medical insurance claim in the Ledger. This has been fixed. 

•	 Minimizing the columns in the Ledger caused them to disappear. This has been fixed.

•	 The Split Claims dialog box displayed amounts incorrectly. This has been fixed. 

•	 Under certain conditions, procedures that involved multiple surface entries were not being posted 
correctly in the Ledger. This has been fixed.  If you printed a Walkout Statement with 21 to 24 
procedures in the Ledger with the Family Walkout and Print Doctor Recommendations options 
selected, an additional blank walkout statement printed with the text Procedure Recommendations 
printed over the text Statement of Services Rendered. This has been fixed. 

•	 If you print a claim with a postdated procedure for a tooth with surfaces and a current date procedure 
with no surfaces, the surfaces print for both procedures. This has been fixed. 

•	 Totals were not updated when an insurance adjustment was entered. This has been fixed. The 
estimated insurance portion of a Primary Dental Insurance Claim was incorrectly reported as $0.00 
when the claim included a cross-coded procedure and a Primary Medical Insurance Claim. This has 
been fixed. 

•	 The secondary insurance override was blank when the user clicked the All (with running balance) 
option in the View menu. This has been fixed. 

•	 The Remove button was missing from the Insurance Claim Information dialog box. This has been 
fixed. 

•	 An “X” was printed in box 8 of the HCFA212 form even though box 8 is reserved for the NUCC. This 
has been fixed. 

•	 Clicking the Fast Checkout button in the toolbar opened the wrong dialog box. This has been fixed. 

•	 Procedures whose check boxes were cleared in the Set Appointment Procedures Complete dialog 
box, were still posted and set as complete. This has been fixed. 

•	 Totals were incorrect when split payments were posted. This has been fixed. 

•	 Splitting payments caused an error message to appear. This has been fixed. 

•	 Splitting payments by family members showed only part of the payment. This has been fixed. 
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•	 Received an error entering an amount over $999.99 in the Batch Insurance Payment Entry dialog box. 
This has been fixed. 

•	 FIFO split payments were posted to providers who had a $0 balance with the selected patient. This 
has been fixed. 

•	 The Apply to Payment Agreement was made inactive once a payment was made to a payment 
agreement and moved to history after closing out a month. This has been fixed. 

OFFICE JOURNAL

•	 If passwords are enabled and the Office Journal is opened, the logged in user is not automatically 
selected. This has been fixed. 

•	 If you deleted a billing statement from the Office Journal and recreated it, Office Journal would not 
refresh to show the new billing statement. This has been fixed. 

•	 If you deleted a billing statement from the Office Journal and recreated it, Office Journal would not 
refresh to show the new billing statement. This has been fixed. 

•	 If you added an Office Journal note with the same Date, Time, and Type as another Office Journal 
note, the message “Error adding record to Journal table: 2” would appear. This message no longer 
appears.

•	 Printing Office Journal entries for a provider would, under some circumstances, cause the report to 
print with the wrong provider’s name at the top. This has been fixed.

•	 A broken appointment in the Office Journal now includes the appointment reasons as part of the 
description.

•	 Opening the Office Journal from the Family File after adding a specific note in the Billing/Payment 
Agreement Information dialog box would cause Dentrix to display a “Runtime Error!” This has been 
fixed.

•	 An Office Journal entry appeared for patients who were referred to the doctor rather than for the 
patient who made the referral. This has been fixed. 

•	 Patient alerts triggered by Add to Office Journal are now displayed when an Office Journal entry 
is added using the Add Journal Entry button in the More Information dialog box. Received error 
message “Unspecified error” when viewing billing statement entries. This has been fixed. 

OFFICE MANAGER

•	 If a procedure was flagged for medical cross coding, setting the Do Not Bill to Dental Insurance 
option had no effect. This has been fixed. 

•	 Could not set a procedure’s time unit to 0 in the Procedure Code Editor dialog box. This has been 
fixed.

•	 Patients with credit balances were excluded from the Referred By Doctor/Other Report. This has been 
fixed 

•	 If a patient had two Continuing Care appointments, the letter merge function incorrectly pulled the 
earliest dated appointment for the postcard reminder. 

•	 Selecting a Continuing Care Type with no description in the Patient Report View dialog box and then 
merging a letter caused all patients with a Continuing Care Type to appear on the View List. This has 
been fixed. 

•	 If you performed a letter merge and a patient had an unscheduled and a scheduled appointment in 
the selected date range, the patient was excluded from the search. This has been fixed. 

•	 Letter Merge and Quick Letters now support long filenames to integrate better with files created in 
Microsoft Word. Fields where these filenames appear have also been extended.

•	 In the Office Manager’s File menu, the Clear (Deselect All) and Refresh options did the same thing. 
The Clear (Deselect All) option was removed, and the Refresh option was renamed to Refresh/Clear. 
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•	 When merging letters in the Office Manager, the position of some fields in the Patient Report View 
dialog box have changed, making it easier to specify the names of the merge files.

•	 In the Office Manager, the Letters menu name was changed to Letters & Custom Lists. The name of 
the dialog box that opens was also changed.  

•	 Running a letter merge for a range of insurance carriers with the same name shows all patients for 
all plans instead of only showing the patients on the plans within the specified range. This has been 
fixed. 

•	 Setting the “Existing Patients with NO appointments in date range” and the “Without Attached 
Appointment” options and then performing a letter merge causes the “No records that match your 
query were found” error message to appear. This has been fixed. 

•	 The Office Manager’s Label Printer settings were not being saved after you closed the Office 
Manager. This has been fixed.

•	 In the Patient Summary Report, the number/count that was reported for Age 65 and Over and for 
Age 12 and Under was not correct for the month of February. This has been fixed.

•	 The Office Manager would stop responding if you tried to add more than 97 providers at one time 
(one after another, without closing the Office Manager). This has been fixed.

•	 In the Office Manager’s Preferences dialog box, if any of the forms on the Statement Forms tab was 
not selected, the Month End Wizard would not show all available options. This has been fixed. 

•	 In the Dental Insurance Plan Information dialog box, the Change Plan for All and Add As A New 
Plan options did not appear after you edited the Employer field. This has been fixed.

•	 In the Office Manager, if you defined a fee schedule name that was seven characters long and then 
edited the fee for a procedure from the Procedure Code Setup dialog box, fees under $10 would not 
be displayed. This has been fixed.

•	 If you tried to add more than 250 staff members, Dentrix displayed an error message but did 
not explain the limitation. Now Dentrix displays a message letting you know that additional staff 
members can’t be added. 

•	 Appointment Type definitions can now be deleted in the Office Manager. 

•	 Adding a student status to medical insurance before the patient’s insurance information was added 
would cause a “Cannot write” error message to appear. This has been fixed—the error message no 
longer appears.

•	 Importing a custom-created fee schedule that had only two columns could cause an “Unhandled 
exception” error message. This has been fixed.

•	 In the Fee Schedule Setup dialog box, if you selected a fee schedule and pressed Delete, the fee 
schedule would immediately be removed from the list without warning. This has been changed—the 
Delete key no longer does anything in this dialog box.

•	 Minor changes were made to the new Fee Schedule feature added in Dentrix G5.2.  

•	 Pre-Submission Reports were not removed from the electronic claims note file if the report was 
deleted from the Batch Processor. This has been fixed.

•	 If you marked a procedure as “Invalidated,” using the Office Manager’s Batch Insurance Claims tool 
would still create a claim for the procedure. This has been fixed.

•	 When attempting to send medical claim forms by selecting the Selected Medical Claim Forms option 
in the Office Manager, the message “No claims were found that match your selection” would appear. 
This has been fixed, and this method of sending medical claim forms no longer displays the message. 

•	 In the Print Preview dialog box, clicking Default Page Size now displays the document using the 
default page size (when the dialog box was opened) rather than using a smaller page size. 

•	 Inactivating a staff member attached to an appointment with a status definition that is blank would 
cause an “Application Error” message to appear. This has been fixed.



22	 Dentrix G6

Dentrix G6 Release Guide

•	 When performing a letter merge, clearing certain options would automatically clear other options. 
Now, letter merge options are only cleared or selected when you click them individually with the 
mouse. 

•	 When merging letters, if the Insert Multiple Referrals in Single Letter option was selected in the Select 
Referred By Range dialog box in the Patient Report View, Dentrix would display a “Header Record 
Delimiter” error followed by multiple “Invalid Merge Field” error messages. This has been fixed.

•	 When using the merge field «PP_Payment_Date», the merge would pull the First Pay Date instead of 
the actual Future Due Payment Due Date. This has been fixed.

•	 The letter merge does not include all of the appointments for patients having multiple appointments 
on the same day. This has been fixed. When a new patient is created and does not yet have a Last 
Visit Date because no work has been completed, letter merge data files would report the Last Visit 
Date the same as the First Visit Date. Now the Last Visit Date is left blank in this situation. 

•	 Selecting the Referred To letter merge filter would clear the Pri Dental Ins filter option. This has been 
fixed.

•	 Opening the Referred By dialog box during a letter merge would clear the letter merge Appointment 
filter. This has been fixed.

•	 When specifying a data range in a letter merge or query, if the beginning field for the range was left 
blank, the query results could be inconsistent and incorrect. This has been fixed.

•	 All letter templates have been updated to improve the writing.

•	 When using letter merge, in some circumstances one patient’s Due Date would be used with the next 
patient also if that patient had a blank Due Date field. This has been fixed.

•	 When using letter merge to create a “Prospective Patients” letter, if you selected the Prospective 
patients with appointment in date range option in the Appointments filter in the Patient Report 
View dialog box, no practice data was in the merged letter. The practice data is now included.

•	 Defining 20 Continuing Care types in Dentrix and selecting the ALL check box for Continuing Care 
types when doing a letter merge would cause the resulting merge data to contain incorrect results 
and cause other problems. This has been fixed.

•	 The Do Not Include Dental Diagnostic Codes option was not enabled in the DX2012 claim form. 
This has been fixed. Printing a Patient Balance Report for a family with more than 18 members on the 
account caused a Dentrix application error. This has been fixed. 

•	 Deleting a payment or an adjustment definition and then selecting a replacement causes an error 
message in PowerPay. This has been fixed. 

•	 Using Quick Letters to print a letter would cause any documents that were open in Word to close 
without warning. This has been fixed. Totals for end balances and total receivables in the Practice 
Analysis Report did not match. This has been fixed. 

•	 Could not set a procedure’s time to 0 units. This has been fixed. 

•	 Copying procedure notes to clinical notes added two blank lines between multiple procedure notes. 
This has been fixed. 

•	 The flag “Use Selected Teeth for Range” incorrectly set tooth ranges to be inclusive of all teeth 
between 19 and 26 instead of setting the range to teeth 19 and 26 only. This has been fixed. 

•	 The List Manager was sorting by Patient Last Name, but not performing a secondary sort according 
to Patient First Name. This has been fixed. 

•	 The Treatment Planner icon was enabled even though a patient was not selected in the List Manager. 
This has been fixed. 

PATIENT CHART

•	 The “Image, Open” password security right was not linked to the toolbar buttons on the Image Panel 
toolbar. From the Patient Chart, you could click Image > Switch To > Digital X-Ray and would see the 
message, “The current user does not have rights,” but if you clicked the Digital X-Ray button from the 
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Image Panel toolbar, you were granted access. Now both ways of accessing Digital X-Ray respond to 
the security right consistently.

•	 If you created a custom procedure code and included a space at the end of the name, the Patient 
Chart would always post the custom code. This has been fixed. 

•	 The Patient Chart label did not display properly when a middle initial was missing from a patient’s 
name. This has been fixed. 

•	 If you set the Progress Notes panel in the Patient Chart to display expanded notes and then changed 
to any other chart view or layout, the expanded notes would return to the default notes view. This has 
been fixed. 

•	 Closing the Patient Chart’s Chart Notations while the Lasso tool was still busy caused an “Unhandled 
exception” message to appear. This has been fixed.

•	 After a claim was created, the provider could be changed. This has been fixed. 

•	 Retainer crowns for different quadrants were painted inconsistently in the Patient Chart. The upper 
left and lower right quadrants painted without connection paint between teeth 4-5, and 20-21; the 
upper right and lower left quadrants painted with connection paint between teeth 12-13, and 28-29. 
These are now painted consistently in all quadrants.

•	 The Patient Chart was loading slowly. This has been fixed. 

•	 If an office upgrades to .NET 4.5.1 and uses Dexis 9/10 and Integrator 3.0, the Patient Chart freezes. 
This has been fixed. 

•	 Viewing the Patient Chart using the View by Progress Notes View after invalidating a posted 
procedure would cause the invalidated procedure to continue displaying. This has been fixed. 

•	 A partial denture would appear painted inconsistently in the Patient Chart using certain tooth ranges. 
This has been fixed.

•	 After a treatment plan containing an extraction is complete, the Patient Chart now displays the 
extraction correctly by no longer displaying the extracted tooth in the chart.

•	 After changing the Patient Chart’s display setup theme three times, it would revert back to the default 
theme. This has been fixed.

•	 When customizing the Patient Chart toolbar (and some other toolbars), if you renamed the Toolbar 
in the Rearrange Commands dialog box, the toolbar changes were not saved after closing and re-
opening the Patient Chart. This has been fixed. 

•	 Editing a procedure button image multiple times could cause the file where the image is stored to 
increase dramatically in size and become corrupt, causing the software to run more slowly. This has 
been fixed. 

•	 When you set the Patient Chart to View Progress Notes By Date and specify a date range for From 
and To, the software now remembers the date range the next time you select this option. 

•	 Clinical note categories did not sort correctly when there were more than 24 categories. This has 
been fixed. 

•	 Clinical note templates that included more than 240 items or more than 1,565 characters in a 
Response Type would display a message saying the computer was out of memory. This has been 
fixed. 

•	 If a clinical note had more than 53 lines, it would print a blank first page before (and sometimes after) 
the clinical note. This has been fixed.

•	 Patient Chart allowed you to post an update to a completed clinical note that was locked and 
entered into history through backdating. This has been changed so that clinical notes which were 
manually moved into history by backdating are locked from editing. 

•	 When editing a procedure that uses a tooth range, if you specified only one tooth for the tooth 
range, the tooth number did not appear in the Tooth Range field. This has been fixed. 
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•	 If a procedure had the treatment area set to Tooth and the paint type set to Surface Restoration, 
posting the code would cause an “Unhandled exception” error message. This has been fixed. 

•	 The position of a chart notation in the Patient Chart shifted when you switched from Work Chart View 
to Full Screen View. This has been fixed.

•	 A date and signatory name were not being added to clinical notes after they had been signed. This 
has been fixed. 

•	 Clicking Copy All only copied one clinical note. This has been fixed. If you clicked the Refresh button 
in the toolbar after copying a medical alert to a clinical note, the alert would not appear in the clinical 
note unless you closed and then re-opened the Chart. This has been fixed. 

•	 Posting treatment planned procedures as complete from the Patient Chart’s Progress Notes caused 
all notations to temporarily disappear. This has been fixed. 

PERIO CHART

•	 The Perio script was using a trailing cursor that allowed the selection to move ahead to the next 
tooth while the bleeding selection was still on the last tooth. This made it possible to enter a mobility 
measurement while the bleeding selection was on the previous tooth but the selection was on the 
next tooth. This would apply the mobility data to two teeth. This has been fixed.

•	 When you charted plaque in the Perio Chart using keyboard shortcuts, the measurements were 
applied to two teeth simultaneously when the script is ready to chart the next tooth. This has been 
fixed. 

•	 The Copy to Clipboard option in Perio Exam Info now copies the actual perio exam information 
instead of the defaults for the selected exam template.

•	 If you opened a new perio exam after inactivating a provider, the new perio exam would use the 
inactivated provider. This has been fixed, and the Perio Chart now uses the correct provider. 

•	 When patient letters are printed along with a perio exam, Dentrix now adds an entry to the Office 
Journal.

•	 When printing clinical notes from the Perio Chart, the Perio Chart would sometimes display a 
message that it had encountered a problem and needed to close. This has been fixed.

•	 When you print a perio chart, the chart information now prints with the practice address rather than 
the provider address (if they are different).

•	 If you closed Perio after entering a Furcation Grade by clicking the FG button, the Save message box 
would not appear. This has been fixed. 

•	 On screen, the CAL measurement would appear in red when a reading exceeded the value you set, 
but when it printed, it only printed in red if it exceeded a value of 7. This has been fixed, and it now 
prints in red when it exceeds the specified value. 

•	 The Print Perio Chart Letters or Charts password security option didn’t restrict access properly. This 
has been fixed. 

QUESTIONNAIRES

•	 Setting an existing questionnaire that contained only PI questions to Respondents: Provider/Staff 
would cause a “System index out of range exceptions” error message to appear. This has been fixed. 

•	 Clicking the List All option on and off from the View menu caused responses for patients other than 
the selected patient to appear. This has been fixed. 

•	 The preview pane did not refresh when you selected a new questionnaire. This has been fixed. 

•	 When setting up a questionnaire, the right-click shortcut menus that were available in Dentrix G3 
were not available in Dentrix G4. These shortcut menus have been restored. 

•	 If you tried to delete an employer from a questionnaire and then update the patient information, 
an error message would appear. A new Clear Employer option has been added under Employer 
Options that lets you clear the employer information.
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•	 Clicking Update Patient Information to attach a new patient questionnaire to a patient record in 
some instances could cause the Questionnaires module to stop responding. This has been fixed. 

•	 The Best Time to Call field would sometimes appear in red in the Update Patient dialog box even 
though nothing had changed. This has been fixed. 

•	 When a questionnaire form has patient information fields, the New with Only Patient Info option is 
now always active.

•	 When creating a new patient record in the Family File from a questionnaire form submitted through 
the web, if the year of the appointment date did not match the current system year, the questionnaire 
would go back to the select patient screen. This no longer happens, and the user is allowed to finish 
creating the new patient record.

•	 If a new patient appointment was selected in the Select Patient dialog box when moving 
questionnaire responses, an “Unhandled exception” error message would appear. This no longer 
happens; instead, the message “You must select an existing patient to move responses” appears. 

•	 In certain cases, a form marked as Provider/Staff Respondent could still be uploaded to the office 
website. When this happens, responses would download and notify users, but the responses would 
not be visible because they were marked as Provider/Staff Respondent. This has been fixed; Provider/
Staff Respondent forms can no longer be uploaded to the office website. 

•	 If you tried to open the Questionnaires module from the Patient Chart when a patient with a long 
name was selected, the Questionnaires module would open without the patient selected. This has 
been fixed.

•	 When using the Select Patient dialog box in the Questionnaires module, if you selected a new 
patient appointment from the Appointments tab, nothing happened. This action now displays the 
message,  “A new patient cannot be selected until their information has been updated in the Family 
File.” If you cleared a toolbar from the right-click menu, the toolbar was still selected in the View > 
Toolbars option. This has been fixed. 

•	 If you tried to open the Questionnaires module from the Patient Chart when a patient with a long 
name was selected, the Questionnaires module would open without the patient selected. This has 
been fixed. 

REPORTS

•	 Printing a Billing Statement from the Print Preview dialog box does not update the Last Statement 
Date field in the Ledger or the Office Journal. This has been fixed. 

•	 In the Practice Advisor Report, the case acceptance totals did not include completed treatment-
planned procedures. This has been fixed. 

•	 Excluding days with no transactions from the Provider A/R Report caused the beginning balance to 
be incorrect when run according to the procedure date. This has been fixed. 

•	 The Deposit Slip showed a single provider for payments split between multiple providers. This has 
been fixed. 

•	 Totals in the Practice Treatment Case Report were incorrect. This has been fixed. 

•	 The Patient Notes Report was not printing correctly when patients had multiple patient alerts. This 
has been fixed. 

•	 When running the Practice Advisor Report, if the fiscal month in Practice Setup had a month of 0 or 
some other invalid value, Dentrix displayed the error message, “Year, Month, And Day Parameters 
Describe An Un-Representable DateTime.” This error message no longer appears.

•	 If you launched Dentrix from the Dentrix Launcher at system startup, running the Daily Huddle Report 
or Practice Advisor Report would cause the error message “Cannot find file specified” to appear. This 
has been fixed.

•	 If a patient had a Future Due Payment Plan and you selected the Payment Plan Notes option when 
you printed or previewed the Patient Notes Report, the report would not generate. This has been 
fixed. 
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•	 Patients without insurance would appear on the Daily Huddle Report with the Insurance not Eligible 
box selected. This has been fixed, and this box is no longer selected on the report.

•	 In the Daily Huddle Report, the Prior Day field now reports statistics for the “prior day” that the office 
was opened. Previously, it would report statistics for the prior day even if the office was closed that 
day. 

•	 The Appointment Book View Report will not print if the patient’s referral has a combined name length 
of 49 characters. This has been fixed. 

•	 If the Appointment Status definition was missing for certain appointments when running the Daily 
Huddle Report, an error message would appear and the report would not be generated. This has 
been fixed; the error message no longer appears and the report will now generate properly. 

•	 On the Daily Huddle Report, some patients who were not past due would still appear under Patients 
who have a family Payment Agreement Past Due on the Scheduled Patients List. This has been fixed. 

•	 The Day Sheet included inactive providers even when the List Inactive option was cleared. This has 
been fixed. 

•	 The Chronological Day Sheet is now sorted chronologically.

•	 The Aging Report did not display the Provider IDs when the sort option By Largest to Smallest 
Balance was selected. This has been fixed.

•	 Generating the Insurance Aging Report for certain groups would produce a report that included 
other groups as well. This has been fixed.

•	 The Insurance Transaction Analysis Report in the Practice Assistant did not include secondary 
insurance information when the Include Secondary Claims option was selected. This has been fixed. 

•	 A treatment plan procedure that is attached to a broken appointment now appears on the 
Unscheduled Treatment Plans Report. 

•	 The Future Due Payment Plan Report would sometimes include an incorrect number of payments and 
negative payment amounts. These issues have been fixed.

•	 The Walkout Statement and the Attending Doctor’s Statement included the Balance Forward amount 
without a description. This has been fixed, and the Balance Forward amount no longer appears on 
these statements. 

•	 If you used the Full - Credit Card Statement form when printing single billing statements, the Credit 
Card information was not included. This has been fixed.

•	 In the Practice Statistics Report, if you added all the percentages from the age statistics, the total 
didn’t always equal 100 percent. This has been fixed. 

•	 Selecting the Include patients without production option in the Referred By Patient Report caused 
production to display in the report as 0 when it should be the production value. This has been fixed. 

•	 Procedure units now display the correct values in box 24G on HCFA and HCFANPI forms. 

•	 The Analysis Summary Report would sometimes count the Patients Seen line on the report for the 
same patient twice. This has been fixed.

•	 The Batch Insurance Payment Entry dialog box did not fit entirely on screen if your resolution was set 
to 1024x768. This has been fixed. 

•	 When using the Document Center printer to print claim forms CAMED3, DX2000, or DX2003 from the 
Ledger, a Dentrix Application error would occur. This has been fixed. 

•	 When using the DX2012F claim form, the Total Fee box was not always the correct total of all 
procedures listed. This has been fixed.

•	 The Practice Analysis - Production Summary Report no longer displays procedures that have a period 
in them (such as D0120.A) if the Proc Code Range field excludes them.

•	 Clicking Statement Notes in the Guarantor Notes dialog box didn’t do anything if the Verify Billing 
Statements to Send option was selected. It now opens the Insert Custom Billing Statement Notes 
dialog box.
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•	 Printing an Unscheduled Treatment Plan Report for an individual patient would also print reports for 
all patients with the same last name. This has been fixed. 

•	 If the Daily Summary option on the Analysis Summary Report is not selected, this summary section no 
longer appears on the printed report. 

•	 When a patient had multiple appointments scheduled on the same day, the Route Slip/Patient Visit 
Form did not print information for the additional appointments on that day. This has been fixed.

•	 If two adjustment types with the same name were included in the Provider A/R Totals Report, one of 
the adjustment types would be duplicated while the other would be missing. This has been fixed. 

•	 If the Include Daily Summary option was selected when printing the Provider AR Totals Report, 
Dentrix would display a message that the report was “Printing to Document Center,” but the report 
would not finish printing. This has been fixed. 

•	 When the Include Check Detail option is selected, the Daily Collections Report now only includes the 
check details in the Check Details part of the report to avoid confusion.

•	 The Referred by Patient Report and Referred to Doctor Report included some names outside of the 
selected range. This has been fixed.

•	 The Patient Visit Form now sorts the operatories correctly. 

•	 The Route Slip now sorts all future appointments chronologically.

•	 The Practice Analysis Report when set to Production By Category would show a procedure code as a 
category if there were procedures that met the report criteria in the [NONE] category. This has been 
fixed.

•	 A Dentrix application error appeared when running an Aging Report with a note exceeding 933 
characters and Print to File selected. This has been fixed. 

•	 Running the Insurance Carrier List Report with Include Subscribers selected did not list the correct 
number of subscribers (2,000 instead of 4,318). This has been fixed. 

•	 When generating an Employer List, the Office Manager would stop responding if the list contained 
more than 20,000 patients attached to employees. This has been fixed. The Practice Advisor Report 
showed all Continuing Care Types on the cover page even if only one was selected. This has been 
fixed. 

TIME CLOCK

•	 The Time Clock Report data didn’t perfectly match the History window data (it was off by a decimal) 
due to a rounding inconsistency. This has been fixed.

•	 The Time Clock now updates immediately after deleting a manual Time Punch Entry.

•	 In the Time Clock tool, the following text was added to the bottom-left corner of the dialog box: 
“Click to the right of ‘In’ or ‘Out’ to add or edit a time.”  

•	 When entering a note on the Time Clock’s History tab, if you typed a “$,” Dentrix would move the 
“$” symbol to the beginning of the note. This has been fixed. 

•	 The text of the warning message that appeared when you inactivated a provider indicating that all 
time clock data for the provider will be removed has been deleted. Time clock data is not removed 
when a provider is inactivated. 

•	 When using the Time Clock’s date range calendar on the History tab, after entering a time value, 
if you clicked the < or > buttons to move to the previous or next month, a Save Changes message 
appeared and the calendar kept scrolling indefinitely. This has been fixed. 

TREATMENT MANAGER

•	 Results were inconsistent depending on the date range set in the Next Appt field in the Treatment 
Manager View dialog box. This has been fixed. 
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•	 The Next Appointment Reason appeared correctly in the Treatment Manager preview window but 
printed with a “CC”  instead of “TP.”  This has been fixed. 

TREATMENT PLANNER

•	 When a treatment plan case that contains a signed consent form is deleted, a warning now appears, 
advising you to print the treatment plan and consent forms to the Document Center. 

•	 If a patient did not sign the consent form, when the patient opened the consent form later, the Name 
field under the signature box would be blank. This has been fixed. 

•	 If you created a consent form in the Treatment Planner and cleared the Do Not Include Procedure 
Codes on Consent Form check box, procedures would not appear on the consent form. This has 
been fixed, and the procedures now appear on the consent form.

•	 If you selected Do Not Include Procedure Codes on Consent Form when creating a new consent 
form and then attached the form to a treatment case, the procedure codes still printed and blank 
space was added to the form. This has been fixed. 

•	 Once you assign a default case note template, you cannot remove it. This has been fixed. 

•	 In the Treatment Planner’s Update Treatment Plan Fees dialog box, the All check box under Billing 
Type for Patient’s Guarantor is now disabled (cannot be changed).

•	 When printing a Treatment Case from the Treatment Planner, if the Signed Consent Forms option 
was selected, the treatment case would print on two pages instead of one. It now prints on a single 
page. 

•	 Treatment Plan Cases were deleted even if patients had signed a consent form. This has been fixed. 

•	 When you print a Treatment Case, the Compared Fee Schedule header text is different from all the 
other text on the report. This has been fixed. 

•	 Updating the procedure fees of treatment cases using the Treatment Plan Fees utility changed 
treatment plan dates to the current date regardless of the status of the treatment case. This has been 
fixed. 

•	 The Treatment Planner did not automatically refresh after making changes to a consent form. This has 
been fixed. 

•	 Under certain conditions, printing a Treatment Plan Case included procedures that were never 
treatment planned. This has been fixed.

•	 Printing a Patient Treatment Case Report no longer cuts off individual procedure values that are 
greater than six digits.

•	 Document formatting in Word was not preserved after using Paste to copy the document into the 
Treatment Planner Consent Forms. The formatting from Word is now preserved.

•	 Under certain situations, completed treatment plans could appear on a treatment plan consent form 
for a new treatment plan. This has been fixed.

•	 If you changed the column order for the Patient Treatment Case Report and selected Save as default, 
Dentrix didn’t save the column order as the default. This has been fixed.

•	 The Unscheduled Treatment Plan Report had an option to choose patients by status, but the Practice 
Treatment Case Report did not. This option was added to the Practice Treatment Case Report. 

•	 Running a Patient Treatment Case Report and excluding certain columns caused subtotals to display 
over other information. This has been fixed.

•	 When printing a Treatment Case, if you selected the Exclude Completed Procedures option, all 
completed procedures were excluded instead of just those in the case. This has been fixed. 

•	 The Treatment Planner now allows you to save a treatment case with a note that is longer than 76 
characters. 



	 Dentrix G6       29

Dentrix G6  Release Guide

•	 When printing a treatment plan, if the Print Secondary Insurance option is selected but the patient 
has no secondary insurance, that column will not print.

•	 Several display issues that could be observed when previewing a treatment case have been fixed. 

•	 Adding Default Consent Forms to a treatment case would cause an “Unhandled exception” error. 
This has been fixed.

•	 The Exclude Completed Procedures option in the Practice Treatment Case Report dialog box did 
not always exclude completed procedures from the report. This has been fixed.

•	 In the Case Detail panel, the Other Fee field showed 0.00 instead of the correct fee for an unnamed 
fee schedule. This has been fixed.

•	 The Treatment Plan Case Report was not taking Special Adjustments into consideration in the Patient 
Balance. This has been fixed.

•	 If you accepted a non-recommended case and rejected the other, any new treatment planned items 
would automatically be assigned to the rejected case. This has been fixed.

•	 When signing a consent form in the treatment planner, providers were listed in the Select Provider/
Staff dialog box, but staff members were not. Staff members are now listed.

•	 In the Treatment Case Report, the deductible to be applied was adding the deductible from all 
patients in family, not just the one patient. It now shows the deductible for just the one patient.

•	 Using the Edit or Delete dialog box to enter an insurance override would not automatically refresh 
the Insurance Coverage amounts displayed in the Treatment Planner. These amounts now refresh 
automatically when a procedure or amount is edited. Print jobs in the Treatment Planner defaulted to 
the Windows printer instead of the Patient Chart printer. This has been fixed. 

•	 The text of a double-digit tooth number overlapped the Description text box when a treatment case 
was printed. This has been fixed. 

MISCELLANEOUS

•	 The Net ID has been replaced by the computer name to address Appointment Book refresh issues.

•	 Dentrix will automatically attempt to restart Dentrix services before sending an “Unable to connect” 
message.

•	 The first Dentrix module that you launch on each workstation resolves the server name to an IP 
address and temporarily stores it for all other modules until they are all closed.

•	 Dentrix Connection Status shows which Dentrix modules are open on which computers.

•	 The procedure code for a missing tooth appeared on a printed claim form but did not appear in box 
37 of the DX2007 claim form. This has been fixed. 

•	 The text of several error messages was clarified and corrected to make them more helpful. 

•	 The Continuing Care module listed patients who did not fit the specified search criteria. This has 
been fixed. 

•	 If a patient has more than one appointment and different providers perform the procedures, the 
Clinical Notes post to the same provider if more than one appointment is set complete for the 
patient. This has been fixed. 

•	 Clicking an appointment in the Appointment Book while generating a continuing care list causes the 
error message, “Cannot read patient file” to appear. This has been fixed. 

•	 A crash that could occur when installing the Dentrix workstation software has been fixed.

•	 Downloading eligibilities automatically caused eSync to crash in some offices. This has been fixed. 

•	 Patients’ Social Security numbers appeared in the Select Patient dialog box even though the Hide 
Social Security Number option had been selected in Practice Setup > Preferences. This has been 
fixed. 
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•	 If you attempted to open a Dentrix module too many times before the module had time to open, 
Dentrix would display the message, “Cannot find previous instance.” Dentrix no longer displays this 
message. 

•	 Several issues having to do with file locks and error messages when multiple instances of a patient 
record are open for editing simultaneously have been fixed.

•	 Archived patients could be accessed in some modules and certain locations of Dentrix where access 
should not have been available. This has been changed, and archived patients can no longer be 
accessed from these areas of Dentrix. 

•	 Duplicate appointments appear in the Appointment List. This has been fixed. 

•	 When the total number of surface selections was more than five, procedures did not show the correct 
procedure flags. This has been fixed. 

•	 When migrating Dentrix to a new server location, the server path in the registry was not always 
updated. This has been fixed.

•	 A problem that caused the message “Module still active” to appear at times when running the month 
end utilities has been fixed.

•	 The eSync software would occasionally stop responding and display a .NET system access violation 
error. This has been fixed.

•	 When no patient is selected on the Appointments tab in the Select Patient dialog box, if you click 
OK, Dentrix now displays the message, “’No patient is selected!”

•	 You could not print to the Document Center Printer if you were using Windows 8 32-bit. This has 
been fixed. 

•	 When you mark a lab case as “received” in the Appointment Book using the Received Case button, 
the “received” status is now updated in the Appointment Book icon, and the received date is now 
posted in the Lab Case Manager. 

•	 In the Select Patient dialog box, if you typed a letter and pressed Enter quickly before any search 
results displayed, an “Unhandled exception” error would appear. This has been fixed.

•	 Some patient searches in the Select Patient dialog box would return inaccurate search results—for 
example, if one person’s last name (Johns) was the same as another person’s last name (John) plus 
their first initial (S, for Steven). 

•	 A scrolling issue when searching by Home Phone # in the Select Patient dialog box was fixed.

•	 When selecting a patient, if you clicked in a blank area of the dialog box so that no name was 
selected, and then clicked OK, an “Unhandled exception” error appeared. This has been fixed. 

•	 The on-screen keyboard (available in several Dentrix modules, such as the Ledger, the Office 
Manager, the Office Journal, and so forth) did not work on 64-bit operating systems. This has been 
fixed. 

•	 A workstation that used a mapped drive to access a database on a server would lose its connection to 
the database after a reboot or a re-login or after coming out of sleep mode. This has been fixed. 

•	 Pressing F1 in most Dentrix modules would open the Dentrix Help. However, in four modules (Lab 
Case Manager, Office Journal, Treatment Manager, and Collection Manager) F1 did not open the 
Help. This has been fixed. 

•	 The color of the Patient Alerts button was incorrect did not correspond to the patient’s condition. This 
has been fixed. 

•	 The Zip Code Change Utility (available on the Maintenance menu in the Office Manager) now lets 
you change ZIP Codes that are longer than five digits.

•	 The end balance and total receivables do not match in the Practice Analysis window. This has been 
fixed. 

•	 The More Information dialog box could be opened by Dentrix users who didn’t have the security 
rights to do so. This has been fixed. The patient’s name had an added comma in the CAMED3 claim 
format. This has been fixed. 
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•	 The Tutor database files were not being copied to the correct folder during installation. This has been 
fixed. 

•	 Users without rights to the common folder incorrectly received the “Unable to connect to the 
database” error message and then received the common sharing error message. This has been fixed. 

•	 The Dental Terms topic in the Help would not open. This has been fixed. 

•	 An error occurred when the Treatment Plan option was selected in the Patient Upload page in the 
Websync Wizard. This has been fixed. 

•	 If the patient you created a detailed chart label for didn’t have an employer specified in the Family 
File, an error occurred. This has been fixed. 

•	 eDex closed shortly after loading patients. This has been fixed. 

•	 The Add Journal Entry option included inactive providers in eDex. This has been fixed. 


